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ในการผลิตช้ินงานดวยกรรมวิธีการตัดโลหะ (machining) ถาระนาบอางอิงในการผลิต 

(manufacturing datums) หรือในการตรวจสอบขนาดช้ินงาน (inspection datums) มีความแตกตาง
ไปจากระนาบอางอิงสําหรับการบอกขนาดแลว ปญหาท่ีจะเกิดขึ้นตามมาก็คือ ความคลาดเคล่ือน
สะสม (tolerance stacks) ซึ่งสงผลใหผูวางแผนกระบวนการผลิตจําเปนจะตองเปล่ียนแปลงคาความ
คลาดเคล่ือนของมิติในการผลิตหรือในการวัดขนาด เพื่อคงไวซึ่งความตองการใชงานของ
ชิ้นงาน (functional requirement) ที่ผูออกแบบไดกําหนดไว ปญหาเชนนี้จัดเปนปญหาของการแบง
หรือกระจายคาความคลาดเคล่ือน (tolerance allocation problems) ซึ่งมักจะเกิดขึ้นอยูเสมอในการ
วางแผนการผลิต การผลิต และการตรวจสอบขนาด และเปนปญหาที่ตองอาศัยประสบการณและ
ความชํานาญของผูวางแผนกระบวนการผลิต ผูออกแบบเกจตรวจสอบ (gage designer) หรือ 
วิศวกรควบคุมคุณภาพ  

งานวิจัยนี้มีวัตถุประสงคเพื่อพัฒนาโปรแกรมคอมพิวเตอรเพื่อใชสําหรับการแบงคาความ
คลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือจุดอางอิงของการผลิตและการตรวจสอบแตกตางไป
จากจุดอางอิงของการบอกขนาด โดยประยุกตเทคนิคของกราฟตนไม (rooted-tree graph) เพื่อสราง
ความสัมพันธระหวางมิติและเทคนิคการหาคาท่ีเหมาะสมท่ีสุดดวยโปรแกรมเชิงเสนตรง (linear 
programming) เพื่อใหไดผลลัพธความคลาดเคล่ือนสําหรับมิติชุดใหมทั้งหมดมีคามากท่ีสุดภายใต
เงื่อนไขความสัมพันธของมิติใชงานและขณะเดียวกันตองอยูในเกณฑที่สามารถผลิตไดในทาง
ปฏิบัติดวยกระบวนการผลิตโดยท่ัว ๆ ไป (processing conditions) 
 โปรแกรมที่พัฒนาข้ึนสามารถหาผลลัพธที่เหมาะสมท่ีสุดใหกับปญหาการแบงคาความ
คลาดเคล่ือนไดคร้ังละหลาย ๆ ชุดคําตอบ โดยไมตองสรางสมการเชิงเสนตรงดวยมือและปอนคา
ใหกับโปรแกรมใหมทุกครั้งเม่ือมีการปรับเปลี่ยนเกณฑความคลาดเคล่ือน ชวยทําใหลดขั้นตอน
และเวลาในการทํางานลงไดมาก โดยที่ผูใชโปรแกรมไมจําเปนตองมีความรูและความชํานาญ
ในทางปฏิบัติมากนัก ก็สามารถกระจายความคลาดเคล่ือนใหกับมิติในการผลิตหรือในการวัดขนาด
ใหม เพื่อคงไวซึ่งความตองการใชงานของช้ินงานที่ผูออกแบบกําหนดไว  
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TOLERANCE ALLOCATION/OPTIMIZATION/LINEAR PROGRAMMING 

 

The problems of tolerance allocation are normally encountered in various 

phases of engineering production ranging from product design, process planning, 

production, to product quality control. To solve such problems requires not only high 

practical experience but also time and efforts. A proper tolerance analysis computer 

package is therefore in need of those personnel involving in aforementioned activities. 

This thesis reports the development of a computerized tolerance allocation 

system, namely, Tolerance Optimization Program (TOLOP). The program is capable 

of optimally allocating blueprint tolerances to a new set of dimensions corresponding 

to the datum for manufacturing. By making use of a rooted-tree graph, all tolerance 

relationship among functional dimensions on a machined part, before and after the 

baseline for dimensioning has been modified, can be created. These relationships and 

other practical machining limitations are taken as the constraints for allocating of 

tolerances with a linear programming algorithm. 

 The Visual Basic language has been used for developing TOLOP for its 

abundant tools for a program development. The inputs required by the package 

include: the number of dimensions involved in a problem, the basic sizes and the 

tolerances together with the end-faces of all old and new sets of dimensions. TOLOP 
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also requires to know a range of the International Tolerance (IT) numbers for the 

machining operation making each dimension. This piece of information enables the 

program to give a solution within a practical feasibility. Futhermore, it requires to be 

entered the number of cycles to execute the routines to obtain the best solution, or a 

set of possible solutions. TOLOP then constructs a rooted-tree for those dimensions 

resulting from the change of datum for dimensioning. This graph records all 

functional dimensions relating to the blueprint dimensions. 

 Starting form a set of the minimum IT numbers for the new set of dimensions, 

TOLOP creates an objective function and a set of linear programming constraints, and 

solves for an optimum solution. It will repeat the routine with different IT numbers 

the number of times specified by the number of executions entered. The user can 

interact with the application to modify the method of applying the IT numbers and the 

number of program runs. 

 TOLOP has been validated by comparing the results from its executions with 

those obtained from two commercial packages Excel and Lindo, and they all agree. 

With 10 linear dimensions and 2 tolerance grades attaching to each dimension, 

TOLOP can give an optimum solution within 10 seconds. It can handle more 

dimensions and tolerance grades at an expense of computing time. 
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บทที่ 1 
บทนํา 

 

1.1 ความเปนมาและความสําคัญของปญหา 
การผลิตช้ินงานดวยกรรมวิธีการตัดโลหะ (machining) ถาหากระนาบอางอิงในการผลิต 

(manufacturing datums) หรือในการตรวจสอบขนาดช้ินงาน (inspection datums) แตกตางไปจาก
ระนาบอางอิงในการบอกขนาดแลว ผลที่จะเกิดขึ้นก็คือปญหาความคลาดเคล่ือนสะสม (tolerance 
stacks) ซึ่ งผู ว างแผนกระบวนการผลิตจํ า เปนตองกระจายค าความคลาดเค ล่ือนใหกับ
มิติ (dimensions) ในการผลิตหรือในการวัดขนาดใหมเพื่อคงไวซึ่งความตองการใชงานของ
ชิ้นงาน (functional requirement) ที่ผูออกแบบกําหนด เราเรียกปญหานี้วา การกระจายหรือแบงคา
ความคลาดเคล่ือน (tolerance allocation) และถึงแมวาในปจจุบันเคร่ืองมือกลที่ใชในการผลิตมี
ความเท่ียงตรงสูงก็ตาม การกระจายคาความคลาดเคล่ือนยังคงเปนเรื่องจําเปนทั้งในดานการ
ออกแบบ การวางแผนการผลิต การผลิต การตรวจสอบ และการประกอบชิ้นงาน ทั้งน้ีเพราะงานตัด
โลหะชนิดหนึ่งสามารถทําไดบนเคร่ืองมือกลที่แตกตางกัน และการตรวจสอบมิติเดียวกันก็สามารถ
ทําไดหลายวิธี นอกจากน้ียังมีชิ้นงานจํานวนมากท่ีตองเปล่ียนตําแหนงการจับช้ินงานหลายคร้ังกวา
การผลิตชิ้นงานจะเสร็จสมบูรณ เพราะฉะน้ันการวิเคราะหความคลาดเคล่ือน (tolerance analysis)
ชนิดน้ีจึงยังคงมีความสําคัญตออุตสาหกรรมการตัดโลหะ โดยเฉพาะอยางยิ่งชิ้นงานท่ีมีหลายมิติ
และมีขั้นตอนในการข้ึนรูปท่ีซับซอน ดังตัวอยางชิ้นงานในรูปที่ 1.1 ซึ่งเปนแบบของชิ้นงานท่ีใช
จริงในอุตสาหกรรม จะเห็นไดวาถาหากระนาบอางอิงของการผลิตเปล่ียนแปลง การกระจายคา
ความคลาดเคล่ือนใหกับมิติของช้ินงานเพื่อการผลิตจะตองใชระยะเวลานานในการพิจารณา
เนื่องจากชิ้นงานมีรูปรางที่ซับซอนและมีงานตัดโลหะหลายชนิดท่ีเกี่ยวของ 
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รูปที่ 1.1 แบบชิ้นงานที่ใชผลิตจริงในอุตสาหกรรม 
 

การกระจายหรือแบงคาความคลาดเคล่ือนใหกับมิติในการผลิตใหมนั้นมีหลักเกณฑวา คา
ความคลาดเคล่ือนมากผลิตไดงายแตไมรับประกันวาชิ้นงานจะใชไดหรือไม คาความคลาดเคล่ือน
นอยผลิตไดยากและตนทุนสูงแตชิ้นงานท่ีผลิตไดสามารถทําหนาท่ีไดเสมอ ดังน้ันการกระจายหรือ
แบงคาความคลาดเคล่ือนจึงตองพยายามใหมิติที่ เกี่ยวของกับความตองการใชงานมีความ
คลาดเคลื่อนมากที่สุด ขณะเดียวกันก็ตองไมทําใหหนาที่ในการใชงานมีความบกพรอง  

หนาท่ีใชงาน (functional requirement) ของชิ้นงานแตละชิ้นเปนสภาวะท่ีชิ้นงานท่ีพิจารณา
สัมพันธกับสวนประกอบอื่น ๆ ของชุดงานประกอบ (assembly) สภาวะเชนนี้จะถูกถายทอดใหกับ
ชิ้นงานประกอบแตละช้ินดวยการกําหนดคาความคลาดเคล่ือนใหกับมิติของช้ินงานท่ีเก่ียวของ ซึ่ง
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เราเรียกมิติที่สัมพันธกับความตองการใชงานของชุดงานประกอบวา  มิติใชงาน  (function 
dimension) ในการผลิตช้ินงานแตละช้ิน มิติใชงานของช้ินงานแตละช้ินก็ คือ ความตองการใชงาน
หรือเปาหมายในการผลิตของช้ินงานนั้น ๆ เพราะถาหากไมสามารถบรรลุเปาหมายนี้ไดก็จะมี
ผลเสียตอหนาที่ใชงานของชุดงานประกอบโดยรวม 

ในปจจุบันมีวิธีการสรางความสัมพันธของความคลาดเคล่ือนในมิติใชงานของชิ้น
สวนประกอบกับความตองการใชงานของชุดงานประกอบอยูหลายวิธี วิธีการเหลาน้ีเปนพื้นฐาน
ของการกระจายความคลาดเคล่ือนในชิ้นงานชิ้นใดช้ินหนึ่งดวย  
 

1.2 การเขียนแผนภาพวงรอบ 
แผนภาพวงรอบ (loop diagram) คือ แผนภาพท่ีแสดงความสัมพันธของความตองการใช

งานของชุดงานประกอบกับมิติใชงานในช้ินสวนประกอบแตละช้ิน การเขียนแผนภาพชนิดนี้เปน
เทคนิคของการออกแบบชุดงานประกอบซ่ึงเปนที่นิยมใชมาเปนเวลานานในอุตสาหกรรม และใน
งานวิจัยทางดานความคลาดเคล่ือน เพราะพบในบทความและหนังสือทางวิชาการมาไมนอยกวา 50 
ป และ C.A. Gladman ไดบันทึกไวอยางเปนระบบในหนังสือเม่ือป 1972 นอกจาก Gladman แลว 
P.Drake และ J.Ligget ก็มีการใชแผนภาพในลักษณะเดียวกันน้ีดวย ถึงแมวาแผนภาพจะมีลักษณะ
เดียวกันแตรายละเอียดของการกําหนดมิติที่ เ ก่ียวของหรือเรียกวา  “มิติใชงาน” (functional 
dimensions) มีความแตกตางกันโดยเฉพาะอยางย่ิง Gladman ไมไดกลาวถึงข้ันตอนหรือวิธีการ
เหลานี้ไวเลย จึงนาจะเขาใจไดวาการกําหนดมิติใชงานนาที่จะตองอาศัยประสบการณในการทํางาน
ทางปฏิบัติดวย ซึ่งความเขาใจเชนนี้ไดรับการยืนยันดวยความแตกตางของวิธีการของ Drake และ 
Ligget ในท่ีนี้จะกลาวถึงวิธีการท้ัง 2 นี้กอนแลวจึงขยายความวิธีการของ Gladman ในภายหลัง 
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 1.2.1 วิธีการของ Drake 
 

75?0
75?0 1.215?0
04?0

5.019?0
8.5?0

5?0
30?0

62.494?0

2.5?0
8.5?0
11.5?

 
 

รูปที่ 1.2 ชิ้นสวนประกอบของมอเตอร (นิ้ว) 
 

พิจารณารูปที่ 1.2 กําหนดให GAP คือ ความตองการใชงานที่ตองมีคามากกวาหรือเทากับ
ศูนย โดย Drake ไดสรุปขั้นตอนการเขียนแผนภาพวงรอบไวดังนี้  
 1) กําหนดใหผิวดานซายของ GAP เปนจุดเร่ิมตนและกําหนดใหผิวดานขวาของ GAP เปน 
  จุดส้ินสุด 
 2) ใชเวคเตอรสรางแผนภาพวงรอบแบบปด จากจุดเร่ิมตนจนถึงจุดส้ินสุด โดยไมรวม  
  GAP (รูปที่ 1.3) 
 3) ใชหัวลูกศรแสดงทิศทางของแตละเวคเตอร โดยระบุเวคเตอรดวยเคร่ืองหมายบวก (+)  
  เม่ือลูกศรช้ีจากซายไปขวา หรือ ระบุเวคเตอรดวยเคร่ืองหมายลบ (-) เม่ือลูกศรช้ีจากขวา 
  ไปซาย 

4) ในรูปเดียวกันน้ีกําหนดชื่อตัวแปรใหแตละมิติและเปล่ียนวิธีการบอกขนาดความ 
 คลาดเคลื่อนใหเปนแบบเบ่ียงเบนจากขนาดมูลฐานเทา ๆ กันท้ังสองขาง 
 (bilateral tolerances) โดยมีตัวอักษรแทนมิติตาง ๆ ดังนี้ X ± x คือ ขอบเขตของ 
 ขนาด GAP ที่ตองการทราบคา; A คือ ขนาดของปลายสกรูถึงผิวลางของหัวสลัก 
 เกลียว หรือ คือ ความยาวของสลักเกลียว; B คือ ความหนาของแหวนรอง (washer);  
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 C คือ ความหนาของแหวนกดแบร่ิง (inner ring bearing cap); D คือ ความหนาของแบริ่ง 
 ตัวแรก (bearing 1); E คือ ความหนาของ spacer; F คือ ความยาวของ rotor; G คือ ความ 
 หนาของ spacer; H คือ ความหนาของแบร่ิงตัวท่ี 2 (bearing 2); I คือ ความยาวของ 
 ปลอกพูลเลย (pulley hub); J คือ ความยาวของเพลา (shaft); K คือ ระยะจากผิวปลาย 
 เพลาถึงกนรู (hole bottom) 

 

  
รูปที่ 1.3 แผนภาพวงรอบสําหรับหาขนาดมูลฐานและความคลาดเคลื่อนของมิติ GAP 

 
5) สรางสมการวงรอบขนาดมูลฐานและสมการวงรอบสําหรับความคลาดเคล่ือนไดดังนี้ 

สมการวงรอบขนาดมูลฐาน : 
X = -A+B+C+D+E+F+G+H+I-J+K                 (1.1) 

         =-0.3595+0.0320+0.0600+0.4305+0.1200+1.5030+0.1200+0.4305+0.4500 
                 -3.0250+0.4000 

X = 0.1615 
สมการวงรอบสําหรับความคลาดเคล่ือน : 

± x = ± (a+b+c+d+e+f+g+h+i+j+k)                 (1.2) 
        = 0.0155+0.0020+0.0030+0.0075+0.0050+0.0070+0.0050+0.0075 
           +0.0070+0.0060+0.0300 
± x = ± 0.0955 

∴ GAP หรือ X ± x = 0.1615 ± 0.0955 
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เปนที่นาสังเกตวา  ขั้นตอนท่ี  Drake เสนอจะเนนเรื่องของทิศทางการพิจารณาจาก 
functional requirement และไมมีกฎเกณฑอยางอ่ืนกํากับ ซึ่งมีโอกาสท่ีจะเกิดมิติของช้ินงาน
เดียวกันซํ้าซอนในสมการวงรอบได 
 1.2.2 วิธีการของ Ligget 

 

 
 

รูปที่ 1.4 ชิ้นสวนประกอบของดิสเบรก 
 

พิจารณารูปที่ 1.4 กําหนดใหมิติ A ถึง F คือมิติในช้ินสวนท่ีเปนองคประกอบของดิสเบรก
และ G คือ ความตองการใชงานที่ตองการทราบคา โดย Ligget มีขั้นตอนการหาสมการวงรอบดังนี้  

1) กําหนดใหผิวดานขวาของ G เปนจุดเร่ิมตนและใหผิวดานซายของ G เปนจุดส้ินสุด 
2) ใชเวคเตอรสรางแผนภาพวงรอบแบบปด จากจุดเร่ิมตนจนถึงจุดส้ินสุด โดยไมรวม 

ชองวาง G 
3) ใชหัวลูกศรแสดงทิศทางของแตละเวคเตอร โดยระบุเวคเตอรดวยเคร่ืองหมายบวก (+)  

เม่ือลูกศรช้ีจากขวาไปซาย หรือ ระบุเวคเตอรดวยเคร่ืองหมายบวกลบ (-) เม่ือลูกศรช้ี 
จากซายไปขวา 

4) กําหนดชื่อตัวแปรใหแตละมิติและเปล่ียนขนาดมูลฐานและความคลาดเคล่ือนใหเทากัน 
ทั้ง 2 ดาน (bilateral tolerances) ดังรูปที่ 1.5  
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รูปที่ 1.5 แผนภาพวงรอบสําหรับหาขนาดมูลฐานและความคลาดเคลื่อนของมิติ G 
 

5) คํานวณหาขนาดมูลฐานโดยใชวิธีทางพีชคณิตคํานวณตามเคร่ืองหมายที่แสดงทิศทาง 
ของแตละมิติไดดังนี้ 
สมการวงรอบขนาดมูลฐาน : 

  X = -A-B-C-D-E+F                   (1.3) 
      = -14.2-30-17.8-48-13.5+125 
  X = 1.5 

6) คํานวณคาความคลาดเคล่ือนโดยการนําความคลาดเคล่ือนทั้งหมดมารวมกันจะได 
สมการวงรอบสําหรับความคลาดเคล่ือนดังนี้ 
สมการวงรอบสําหรับความคลาดเคล่ือน : 

± x = ±(a+b+c+d+e+f)                   (1.4) 
       = ±(0.2+0.4+0.2+0.1+0.1+0.1) 
± x = ±1.1 

∴ G หรือ X ± x = 1.5 ± 1.1 
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 1.2.3 วิธีการของ Gladman 
 อันท่ีจริง Gladman ใชสมการวงรอบในการวิเคราะหความสัมพันธระหวางมิติมา
โดยตลอดโดยแยกเปนสมการสําหรับขนาดมูลฐานและสมการสําหรับความคลาดเคล่ือน ดังท่ีได
กลาวมาแลวในตอนตน และยังไมมีการต้ังกฎเกณฑการพิจารณากําหนดมิติใชงาน (function 
dimensions) ที่เก่ียวของกับความตองการใชงานแตอยางใด ที่เปนเชนนี้อาจเปนเพราะในงานดาน
วิศวกรรมเคร่ืองมือ  (tool engineering) ความรูในเร่ืองน้ีเปนความรูพื้นฐานของชางหรือผูมี
ประสบการณในทางปฏิบัติก็ได จนกระทั่ง Sermsuti-anuwat (2009) ไดสรุปแนวทางการประยุกต 
ใชของ Gladman และไดอธิบายขั้นตอนการเขียนแผนภาพวงรอบสําหรับงานประกอบไวอยางเปน
ระบบและชัดเจน เปนข้ันตอนดังนี้ 

 

 
 

รูปที่ 1.6 ชิ้นงานประกอบ 
 
 จากรูปที่ 1.6 แสดงช้ินงานประกอบท่ีมีชิ้นสวนประกอบท้ังหมด 4 ชิ้น (หมายเลข 
1-4) ความตองการใชงานในการประกอบนี้ คือ ระยะหางระหวางช้ินสวนที่ 4 และช้ินสวนที่ 1 ซึ่ง
เขียนแทนดวยมิติ X ± x เพื่อท่ีจะหามิติใชงานท่ีสงผลทําใหขนาดของชองวางเปล่ียนแปลงโดยการ
ใชแผนภาพวงรอบ สามารถทําไดอยางงายโดยมีขั้นตอนการวิเคราะหดังตอไปนี้ 
  1) เขียนลูกศรจากผิวแรกของมิติความตองการใชงานแลวเขียนหัวลูกศรไปยังอีก 

ผิวหน่ึงของชิ้นสวนเดียวกัน ซึ่งผิว ๆ นี้จะตองมีความสัมผัสกับผิวช้ินสวน 
อื่น ลูกศรหมายเลข 1 ในรูปที่ 1.6 คือผลลัพธของข้ันตอนน้ี โดยเร่ิมจากผิวของ
ชิ้นงานหมายเลข 1 ที่ติดกับชองวางแลวเขียนลูกศรไปยังผิวของช้ินสวน
หมายเลข 2 ในตําแหนงท่ีตรงขามกัน ลูกศรน้ีแสดงมิติใชงานของช้ินสวน
หมายเลข 1  
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ในการพิจารณาวามิติใดเปนมิติใชงานใหสังเกตดูวาความตองการใชงาน
เปล่ียนแปลงหรือไม เม่ือมิติที่พิจารณาเปล่ียนแปลงในขณะท่ีมิติอื่น ๆ คงท่ี 

  2) เขียนลูกศรหมายเลข 2 จากผิวท่ีสัมผัสกับหัวลูกศรหมายเลข 1 ไปยังอีกผิวหน่ึง 
ของชิ้นสวนหมายเลข 2 ที่ติดกับผิวของช้ินสวนหมายเลข 3 ลูกศรน้ีแสดงมิติใช 
งานของช้ินสวนหมายเลข 2 

  3) ทําซํ้าในขอที่ 2) จนกระท่ังลูกศรยอนกลับไปหาอีกขอบหนึ่งของมิติความ 
ตองการใชงาน จากน้ันใหหยุดกระบวนการทํางานก็จะไดแผนภาพวงรอบที่ 
เสร็จสมบูรณ มิติใชงานทั้งหมดที่มีผลตอขนาดของชองวางจะรวมอยูใน 
แผนภาพ 

 ซึ่งขั้นตอนท่ีกลาวมาน้ีจะคลายกับเทคนิคทั้งสองที่กลาวมาขางตน แตในบทความ
นี้ไดใหหลักเกณฑในการพิจารณามิติใชงานท่ีเกี่ยวของกับความตองการใชงานไววา ชิ้นสวน
ประกอบหน่ึงชิ้นจะตองที่มีมิติใชงานเพียงหนึ่งมิติเทานั้น เนื่องจากชิ้นสวนในงานประกอบหน่ึงช้ิน
จะมีเพียงสองดานที่สัมผัสกับช้ินสวนอ่ืน ๆ ซึ่งดานทั้งสองเปนมิติเชิงเสนตรงมิติเดียว นอกจากน้ัน
ยังไดเสนอแนะกฏเกณฑอันเปนวิธีการสรางความสัมพันธของตัวแปรในสมการวงรอบไวอกีดวย  

  

1.3 ปญหาของวิธีการเขียนแผนภาพวงรอบ 
 แมวาโดยท่ัวไปแผนภาพวงรอบจะเปนที่ยอมรับกันในเรื่องการหาความสัมพันธระหวาง
มิติที่เก่ียวของกับความตองการใชงาน แต แตละวิธีการหรือแตละเทคนิคจะมีรายละเอียดที่สะทอน
ถึงประสบการณของผูใชที่แตกตางกัน ตัวอยางเชน Drake แล Ligget ไมไดเนนถึงจํานวนมิติของ
ชิ้นงานแตละช้ินในสมการวงรอบ แต Gladman เนน 

ถาพิจารณาตัวอยางชิ้นงานประกอบของ Ligget โดยใชหลักเกณฑที่กลาวไวในบทความ
ของ Sermsuti-anuwat (2009) จะพบวามิติ J (แสดงเปนเสนประ) ของโครงดิสเบรกเปนมิติใชงานท่ี
เกี่ยวของกับ G สวน E และ F เปนผลของการเปล่ียนแปลงเดตัมของการบอกขนาดในโครงดิสเบรก
เทาน้ัน แตดวยประสบการณของ Ligget มิติ E และ F สามารถนํามาใชแทน J ได เพราะความคลาด
เคลื่อนของ E และ F เปนผลลัพธจากการกระจายความคลาดเคล่ือนของ J 

แผนภาพวงรอบสามารถแสดงความสัมพันธของมิติระหวางชิ้นงานไดดี แตกฏเกณฑใน
การเขียนแผนภาพวงรอบเพื่อใหไดมาซ่ึงสมการวงรอบน้ัน ยังไมสามารถครอบคลุมไปถึงกรณีของ
มิติหลายมิติในช้ินงานเดียวกันได  
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1.4 วิธีการทั่วไปสําหรับแบงคาความคลาดเคล่ือน (manual allocation of  
 tolerances) 

พิจารณาช้ินงานกลึง (stepped-shaft) ในรูปที่ 1.7 ซึ่งมีการบอกขนาดความยาวของสวน
ตาง  ๆ  4 มิ ติ  คือ  A ± a, B ± b, C ± c และ  D ± d จะเห็นไดว า  4 มิ ติบอกตําแหนงรูปลักษณ  5 
รูปลักษณ (หรือ 5 ผิว) หรือพูดไดวาจํานวนมิติจะนอยกวาจํานวนรูปลักษณที่มิติอางถึงอยู 1 เสมอ 
 

 
 

รูปที่ 1.7 ชิ้นงานกลึง 
 

 โดยหลักการในการบอกขนาดในแบบจะไมมีมิติ X ± x แตถาตองการทราบผิว m และ n 
จะหางกันเทาใด เม่ือชิ้นงานไดรับการตัดกลึงตามมิติอื่น ๆ ของชิ้นงาน X ± x จึงถูกสมมุติขึ้นเปน

ระยะหางระหวางผิว m และ n ดังน้ัน ถา X สูงสุด หรือ Xmax หรือ (X + x) จึงหาไดจาก:  

 

minminminmaxmax C -B  -A - D  X =  

 c)-(C-b)-(B-a)-(A-d)(D +=  
 d)db(a  C)-B-A-(D ++++=                (1.5) 
ในทํานองเดียวกัน 

 
 minX หรือ (X-x) maxmaxmaxmin CBAD −−−=  

 c)(C-b)(B-a)(A-d)-(D +++=  
 d)cb(a - C)-B-A-(D +++=                (1.6) 
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  ∴

d)cb(aC)BA(D
d)cb(aC)BA(D

X
X

min

max

+++−−−−
++++−−−

=   

 
หรือเขียนไดเปน 

 
       d)cb(a  C)-B-A-(D xX +++±=±                (1.7) 
 

เม่ือเขียนแยกเปนสมการวงรอบ 2 สมการจะได 
สมการสําหรับขนาดมูลฐาน : 

 
CBADX −−−=                 (1.8) 

 
สมการสําหรับความคลาดเคล่ือน : 

 
d)cb(ax +++±=±                 (1.9) 

 
 จะเห็นไดวาความเบี่ยงเบน ±x หรือ (ความคลาดเคล่ือน 2x)*นี้เปนผลรวมของความ
เบ่ียงเบน  (หรือความคลาดเคล่ือน) ของมิติอื่น  ๆ  ทั้งหมด  เราเรียกความเบ่ียงเบน  ±x หรือ 
(ความคลาดเคล่ือน 2x)*นี้วา ความคลาดเคล่ือนสะสม (tolerance stack) 

การประยุกตใชงานท่ีเกิดขึ้นอยูเสมอ คือ เม่ือเดตัมของการบอกขนาดในแบบไมเหมือนกับ
เดตัมของการผลิต (manufacturing datum) ตัวอยางเชน ในรูปท่ี 1.8 แสดงแบบช้ินงานหลอ ซึ่งตอง 
การกลึงเพลาและกัด (milling) ใหเปนรอง ถาตองทําตามแบบจริง ๆ ก็ตองปาดหนา (facing) ผิว A 
และ D กอนแลวจึงกัดรองลึก 14.925±0.075 mm แลวจากนั้นจึงกลึง (เพราะตองวัด 35.5±0.15 mm 
จากกนรอง) แตในทางปฏิบัติจะทํางานกลึงกอนแลวจึงกัดรอง นั้นคือ ตองทราบมิติ X2±x2 ถึงจะ
กลึงได ซึ่งสามารถหาไดจากสมการ 1.8 และ 1.9 ดังนี้ 
 

สมการขนาดมูลฐาน :       X2 – 14.925 = 35.5  

∴X2 = 50.425 
 
______________________________________________________________________________ 
* แมวาความคลาดเคลื่อนของมิติคอืความแตกตางของขนาดใหญสุดกับขนาดเล็กสุดก็ตาม แตในเร่ืองของการ
วิเคราะหความคลาดเคล่ือนนั้น นิยมเรียกความเบ่ียงเบนเปนความคลาดเคล่ือนเชน ความคลาดเคล่ือน ±x ซึ่งใน
ความหมายจริง คือ 2x 



 

 

 

 

 

 

 

 

 

12 

สมการความคลาดเคล่ือน :  ± (x2 + 0.075) ≤ ± 0.15  

∴x2 = ± 0.075 

∴ X2 ± x2 = 50.425 ± 0.075 mm 

 

 
 

รูปที่ 1.8 แบบของชิ้นงานตัด-กลึง 
 

1.5 กราฟตนไม (rooted-tree graph) 
 เนื่องจากการใชคาสูงสุดและคาตํ่าสุดคํานวณความคลาดเคล่ือนสะสมเปนวิธีที่ลาชา ยาก
แกการตรวจสอบและไมสะดวกตอการผูกเปนสมการ จึงจําเปนตองคนหาวิธีการอื่นท่ีเหมาะสมกวา 
การใชกราฟตนไมโดย  Whybrew, Britton, Robinson and Sermsuti-anuwat (1990) ประสบผล 
สําเร็จ  ในการสรางความสัมพันธระหวางรอยตัดของแผนภูมิความคลาดเคล่ือน  (tolerance 
charts) โดยกราฟดังกลาวสามารถบันทึกความสัมพันธของความคลาดเคล่ือนของทุกรอยตัดต้ังแต
เริ่มตนจนสําเร็จเปนช้ินงานตามขอกําหนดในแบบ 

ในงานวิจัยนี้อาศัยแนวความคิดดังกลาว โดยถือวามิติแตละมิติในช้ินงาน คือ รอยตัดท่ีเกิด
จากแตละข้ันตอนของการตัดโลหะ เพราะฉะนั้นจึงสามารถท่ีจะนํากราฟตนไมมาใชสราง
ความสัมพันธระหวางความคลาดเคล่ือนได และมีการนําแนวความคิดของการใชกราฟตนไมไป
สรางเง่ือนไขสําหรับแกปญหาดวยสมการเชิงเสนแลวหาคําตอบดวย Excel (อรวรรณ นงนุช และ 
ยงยุทธ เสริมสุธีอนุวัฒน, 2552) ซึ่งไดผลเปนท่ีนาพอใจ  

เพื่อแสดงการประยุกตใชวิธีการกราฟตนไม พิจารณารูปที่ 1.8 อีกครั้ง ตัวเลขบอกขนาด
ดานบนของรูป คือ ตัวเลขบอกขนาดตามแบบ เราจะเรียกวา มิติชุดเกา ซึ่งใชผิว C เปนระนาบ
อางอิงใหกับผิว B และผิว D เปนการบอกขนาดท่ีไมเหมาะสมสําหรับการผลิต เน่ืองจากถาให
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ผิว C เปนผิวอางอิงของการบอกขนาด ดังน้ันผิว C จะตองไดรับการกัดรองกอนเพื่อเปนผิวอางอิง
ใหกับผิว B และผิว D แตปญหาท่ีจะเกิดตามมาก็คือ ความยุงยากในการต้ังเคร่ืองมือตัด (tool set-
up) จะเพิ่มมากขึ้นและการวัดขนาดของความยาวท่ีจะตองกลึงปอกของ Ø39 ซึ่งสัมพันธกับ
ผิว C เพราะฉะน้ันจึงจําเปนตองเปล่ียนแปลงระนาบอางอิงของการบอกขนาดในแบบใหเหมาะสม
กับระนาบอางอิงในการผลิตและการตรวจสอบใหม คือ ใชผิว D เปนระนาบอางอิงใหกับผิว B และ
ผิว C โดยการบอกขนาดของมิติชุดใหมนี้อยูทางดานลางของรูป สําหรับปญหาในรูปที่ 1.8 เรา
สามารถเขียนกราฟไดดังรูปที่ 1.9 และสามารถสรางสมการวงรอบจากกราฟไดดังนี้ 

 

 
 

รูปที่ 1.9 กราฟตนไม 
 

สมการวงรอบขนาดมูลฐาน:  
 X1 = Y1               (1.10) 
 
 X2-X1 = Y2               (1.11) 

 
สมการวงรอบสําหรับความคลาดเคลื่อน : 

 x1 ≤ y1                (1.12) 
 
 x1+x2 ≤ y2                (1.13) 
 
 จะเห็นไดวาสมการสําหรับขนาดมูลฐานจะบวกหรือลบกันตามเคร่ืองหมาย แตสมการของ
คาความคลาดเคล่ือนจะเปนผลบวกเสมอ ซึ่งในการกระจายความคลาดเคล่ือนน้ันจะอาศัยสมการท่ี 
(1.12) และ (1.13) กลาวคือ ผลรวมของความคลาดเคล่ือนของมิติใหมตองไมเกินความคลาดเคล่ือน
ของมิติเดิมที่กําหนดไวแลว  
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1.6 วัตถุประสงค 
วัตถุประสงคหลักในการทํางานวิจัยครั้งน้ี คือ การเขียนโปรแกรมคอมพิวเตอรเพื่อนํามาใช

สําหรับแบงคาความคลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือจุดอางอิงของการผลิตและการ
ตรวจสอบแตกตางไปจากจุดอางอิงของการบอกขนาดในแบบ โดยอาศัยเทคนิคของกราฟตนไมใน
การหาความสัมพันธของสมการใหอยู ในรูปแบบของการโปรแกรมเชิงเสนตรง  (linear 
programming) และหาผลลัพธโดยใชเทคนิคการหาคาที่เหมาะสม (optimization techniques) เพื่อให
แนใจไดวาความคลาดเคล่ือนท่ีถูกกําหนดใหกับมิติทั้งหมดน้ันมีคามากท่ีสุดภายใตเงื่อนไข
ความสัมพันธของมิติและขณะเดียวกันก็ตองอยูในเกณฑที่สามารถผลิตไดดวยกระบวนการผลิต
โดยเฉลี่ย (average processing conditions) และนอกจากนี้ยังมีวัตถุประสงครองเพื่อหาวิธีที่สะดวก
และรวดเร็วสําหรับคํานวณหรือตรวจสอบความคลาดเคล่ือนสะสมเพ่ือใชเปนพื้นฐานสําหรับการ
วางแผนข้ันตอนในการตัดโลหะ (machining sequence) ตลอดจนสามารถนําไปใชในการออกแบบ
อุปกรณยึด (work holding devices) เชน จิกและฟกซเจอรได 
 

1.7 ขอบเขตและสมมุติฐานของงานวิจัย 
การวิจัยน้ีจะเปนเรื่องของความคลาดเคล่ือนของมิติเชิงเสนตรงธรรมดา (conventional 

tolerancing method) เทาน้ันโดยสมมุติวาเคร่ืองมือกลมีความสามารถในสภาพเฉล่ีย ซึ่งสามารถให
ค าความคลาด เค ล่ือนตามมาตรฐาน  ISO 286-2 และไม รวม ถึงความคลาด เค ล่ือน เ ชิ ง
เรขาคณิต  (geometric tolerance) และยังคงอยูกับแนวความคิดของการผลิตแบบสับเปลี่ยน
ได  100% (100% interchangeable manufacture) เพี ยงอย าง เดี ยว  นั่นคือ  ยั งไมรวมไปถึ งการ
ประยุกตใชหลักสถิติกับความคลาดเคล่ือนทั้งหลายท่ีเกี่ยวของ 
 

1.8 สรุป 
ปญหาการกระจายหรือแบงคาความคลาดเคล่ือน เกิดขึ้นจากปญหาความคลาดเคลื่อน

สะสมของช้ินงานท่ีมีระนาบอางอิงในการผลิตแตกตางไปจากระนาบอางอิงในการบอก
ขนาด ดังนั้นผูวางแผนกระบวนการผลิตจําเปนตองกระจายคาความคลาดเคลื่อนใหกับมิติ 
(dimensions) ในการผลิตหรือในการวัดขนาดใหมเพื่อใหความตองการใชงานของช้ินงาน 
(functional requirement) คงเดิม การวิเคราะหความคลาดเคล่ือนชนิดน้ีอาศัยเทคนิคของแผนภาพ
วงรอบ ซึ่งเปนวิธีการท่ีนิยมใชในอุตสาหกรรมมาเปนเวลานานกวา 50 ป  

แผนภาพวงรอบเปนเทคนิคท่ีใชในการแสดงความสัมพันธของความตองการใชงานของชุด
งานประกอบกับมิติใชงานของช้ินสวนประกอบแตละช้ินเพื่อใชสรางสมการวงรอบ ซึ่งเปนวิธีการ
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ที่ใชสําหรับการคํานวณเพื่อปรับปรุงแบบของชิ้นงานใหสะดวกตอการผลิต นอกจากน้ันการใช
สมการวงรอบสามารถลดความชํานาญและประสบการณของผูออกแบบกระบวนการ
ผลิต (process planner) ได แตอยางไรก็ตามวิธีการน้ีก็ยังมีขอจํากัดในเร่ืองของการนําไปใชกับ
ชิ้นงานท่ีมีรูปรางซับซอน ซึ่งยังคงเปนปญหาของการออกแบบทางวิศวกรรม ดังน้ันจึงไดมีการ
พัฒนารูปแบบของการคํานวณโดยการประยุกตใชเทคนิคกราฟตนไมกับเทคนิคการหาคาที่
เหมาะสมใหอยูในรูปแบบของโปรแกรมคอมพิวเตอรเพื่อใหสามารถนําไปใชในการออกแบบ
ชิ้นงานที่มี่รูปรางซับซอนไดงายและรวดเร็วมากยิ่งขึ้น 



 

 

 

 

 

 

 

 

บทที่ 2 
ปริทัศนวรรณกรรมและงานวิจัยที่เกี่ยวของ 

 

 การวิเคราะหความคลาดเคลื่อน (tolerance analysis) เปนเรื่องเกี่ยวกับการพิจารณาแยก
องคประกอบของความคลาดเคล่ือนของความตองการใชงานออกเปนสวน ๆ กําหนดความคลาด
เคล่ือนท่ีเหมาะสมใหกับแตละองคประกอบยอยและประเมินความสัมพันธขององคประกอบ
ทั้งหลายท่ีมีผลตอการใชงาน เพราะฉะนั้น เรื่องของการวิเคราะหความคลาดเคล่ือนของชุดงาน
ประกอบจึงครอบคลุมต้ังแตแยกความคลาดเคลื่อนของชุดงานประกอบหรือของมิติในช้ินสวนแต
ละช้ินแลวแบงหรือกําหนดคาความคลาดเคล่ือนท่ีเหมาะสม ซึ่งเรียกวา tolerance allocation ไป
จนถึงการสรางความสัมพันธระหวางความคลาดเคล่ือนที่เรียกวา tolerance chain หรือ tolerance 
relationship  
 

2.1 วิธีการวิเคราะหความคลาดเคล่ือน 
 วิธีการวิเคราะหความคลาดเคล่ือนแยกออกไดเปน 2 แบบ คือ วิธีการวิเคราะหในช้ินงาน
ประกอบและวิธีวิเคราะหในชิ้นงานเดี่ยว ซึ่งแตละวิธีแมวาจะมีความแตกตางกันในรายละเอียดของ
การดําเนินการ แตถาสามารถสรุปไดเปนสมการแสดงความสัมพันธระหวางมิติหรือความ
คลาดเคลื่อนในรูปแบบเดียวกัน คือ สมการวงรอบ (loop equation) สําหรับขนาดมูลฐานและ
สําหรับความคลาดเคล่ือน 

2.1.1 การวิเคราะหความคลาดเคลื่อนในช้ินงานประกอบ 
 การวิเคราะหความคลาดเคล่ือนในช้ินงานประกอบสวนใหญอาศัยการพิจารณา

จากแผนภาพประกอบแลวใชประสบการณกําหนดมิติใชงาน  (functional dimensions) ที่มี
ผลกระทบตอความตองการใชงาน (functional requirement) ของชุดงานประกอบ ดังท่ีไดกลาว
มาแล ว ในบท ท่ี  1 ใน เ รื่ อ งของการสร า งสมการวงรอบจากกฎ เกณฑของ  Drake หรือ 
ของ Ligget เปนตน ซึ่งผลของการวิเคราะหก็คือ สมการแสดงความสัมพันธของความคลาดเคล่ือน
ของมิติในช้ินงานท่ีเปนองคประกอบ วิธีการเหลาน้ีเปนวิธีการที่ผูชํานาญใชในทางปฏิบัติอยู
เสมอ และมีหลักการใหญ ๆ คลาย ๆ กัน เพียงแตมีรายละเอียดท่ีแตกตางกันตามประสบการณของ
แตละบุคคลเทาน้ัน นอกจากน้ียังมีความแตกตางกันในการเรียกความสัมพันธ เชน สมการ
วงรอบ (loop equations) และ ลูกโซความสัมพันธ (chain relationship) เปนตน 
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 นักวิจัยทางดานเทคโนโลยีความคลาดเคล่ือน (tolerance technology) ตระหนักถึง
ความสัมพันธเชนนี้มานานไมนอยกวา 70 ป ดังที่ Early and Johnson (1962) ไดใหความสําคัญตอ
การวิเคราะหความคลาดเคลื่อนในงานทางดานวิศวกรรมเคร่ืองมือและในการวางแผนกระบวนการ
ผลิต (process plainning) ตามลําดับ 

 การประยุกตใชความสัมพันธลูกโซที่ เดนชัดที่สุดปรากฎอยู ในงานของ 
Bjørke (1978) โดยการนําสมการดังกลาวไวในโปรแกรมท่ีเขาพัฒนาขึ้นสําหรับวิเคราะหความ
คลาดเคลื่อนเชิงเสนตรงของชุดงานประกอบ อยางไรก็ตาม เนื่องจากความแตกตางในกฎเกณฑการ
สรางสมการหรือความสัมพันธของความคลาดเคล่ือนของมิติทําใหยากแกการประยุกตใช Sermsuti-
anuwat (2009) จึงไดสรุปหลักการของ Gladman เพื่อใหการสรางความสัมพันธของมิติเชิงเสนตรง
สามารถใหคําตอบเดียวกัน เปนกฎเกณฑ 3 ขอ ดังที่ไดกลาวมาแลว ที่สําคัญคือ มิติใชงานใน
ชิ้นสวนประกอบหน่ึง ๆ จะมีเพียงมิติเดียวเทานั้น 

2.1.2 การวิเคราะหความคลาดเคลื่อนในช้ินงานช้ินเดียว 
 เปนการวิเคราะหความคลาดเคล่ือนที่เกิดจากระนาบอางอิงในการผลิตแตกตางจาก

ระนาบอางอิงในการออกแบบ วิธีวิเคราะหที่นิยมใชในทางปฏิบัติและเปนวิธีดั้งเดิม คือ การหา
คาสูงสุดและคาตํ่าสุดของมิติที่สนใจ จากมิติที่มีอยูทั้งหมด ดังท่ีไดกลาวมาแลวในบทที่ 1 แตขอเสีย
ของวิธีนี้คือ ตองอาศัยประสบการณของผูวิ เคราะหและเสียเวลาในการตัดสินใจเลือกมิติที่
เกี่ยวของ การวิเคราะหความคลาดเคล่ือนท่ีจัดวาเปนระบบมากท่ีสุด คือ การสรางแผนภูมิความ
คลาดเคล่ือน ซึ่งใชในทางปฏิบัติต้ังแตตนศตวรรษท่ี 20 จนมีบทความแสดงผลงานวิจัยอยาง
ตอเนื่องในชวง ค.ศ. 1950 เศษ ๆ อยางไรก็ตาม เทคนิคหรือวิธีการน้ียังคงจํากัดอยูในวงแคบเพราะ
ตองใชเวลาทําแผนภูมิมากและหลักการของแผนภูมิเองก็ยังยากแกการทําความเขาใจ จนกระทั้งเม่ือ
ป ค.ศ. 1984 Ahaluwalia and Korolin (1984) ไดตีพิมพบทความของการประยุกตใชคอมพิวเตอร
สรางแผนภูมิความคลาดเคลื่อน เทคนิคนี้จึงฟนกลับคืนมาอีกครั้ง และในปเดียวกันนั้นเอง 
Farmer and Harris (1984) ไดแสดงการกระจายความคลาดเคล่ือนใหกับมิติตาง ๆ ดวยคอมพิวเตอร 
 ทั้งแผนภูมิความคลาดเคล่ือนและผลงานของ Farmer and Harris (1984) ตางก็เปน
การวิเคราะหความคลาดเคล่ือนสะสมและมีผลตอความตองการใชงานของช้ินสวนท่ีพิจารณา 
ถึงแมวา  Farmer and Harris จะใชสมการความคลาดเคล่ือนเปนหลักในการกระจายความ
คลาดเคล่ือน แตการกําหนดมิติใชงานในสมการความคลาดเคล่ือนยังคงตองอาศัยประสบการณ
ในทางปฏิบัติเปนสําคัญ 
 
 



 

 

 

 

 

 

 

 

  

18 

2.2 การใชคอมพิวเตอรชวยในการวิเคราะหความคลาดเคล่ือน 
การใชคอมพิวเตอรวิเคราะหความคลาดเคล่ือนอยางจริงจังมีมานานกวา 30 ป ผลงาน

ของ Bjørke (1978) แสดงใหเห็นถึงความสําเร็จในการพัฒนาโปรแกรมสําหรับคํานวณคาความ
คลาดเคล่ือนสะสม และทําการหาคาความคลาดเคล่ือนที่เหมาะสมในเครื่องคอมพิวเตอรขนาด
ใหญ  (mainframe) แตในเวลานั้นงานวิจัยด านน้ียั งอยู ในวงแคบ  ซึ่ งอาจเปนเพราะว าขีด
ความสามารถท่ีจํากัดของเครื่องคอมพิวเตอรเองหรือราคาคอมพิวเตอรที่ยังสูงอยู บทบาทของ
คอมพิวเตอรเร่ิมชัดเจนข้ึนเม่ือ Ahaluwalia and Karolin (1984) รายงานการใชคอมพิวเตอรสราง
แผนภูมิความคลาดเคลื่อน (tolerance chart) และในปเดียวกัน Farmer and Harris (1984) ไดพัฒนา
โปรแกรมคอมพิวเตอรสําหรับคํานวณคาคลาดเคล่ือนใหกับมิติตาง ๆ ที่ถูกกําหนดขึ้นเม่ือเกิดการ
เปล่ียนแปลงเดตัมของการบอกขนาดในแบบวิศวกรรมโดยใชวิธีการสรางสมการวงรอบเปน
พื้นฐานของการกระจายคาความคลาดเคล่ือน ผลงานที่กลาวขางตนอาจถือไดวาเปนจุดเริ่มตนของ
การประยุกตใชคอมพิวเตอรสําหรับวิเคราะหความคลาดเคล่ือนใหเปนไปอยางกวางขวาง และ
หลังจากน้ัน Fainguelernt, Weill and Bourdet (1986) พยายามแสดงใหเห็นถึงความเปนไปไดใน
การคํานวณหาขนาดและคาความคลาดเคลื่อนบนเคร่ืองคอมพิวเตอรขนาดเล็ก (micro computer) 
โดยใชเทคนิคการหาคาที่เหมาะสมดวยวิธีการโปรแกรมเชิงเสนตรง 
 

2.3 การประยุกตใชเทคนิคกราฟในการวิเคราะหความคลาดเคล่ือน 

การนําเทคนิคของกราฟมาประยุกตใชกับการสรางความสัมพันธของความคลาดเคล่ือน
เปนวิธีหนึ่งที่ทําไดงายและสามารถนําไปสรางเปนแบบจําลองทางคณิตศาสตร (mathematical 
model) โดยใชความเชื่อมโยงของเสนทาง (path) ที่แสดงความสัมพันธของมิติตาง ๆ เปนตัวสราง
สมการความสัมพันธของความคลาดเคล่ือน เพื่อใชในการคํานวณหาคาท่ีเหมาะสมดวยวิธีการ
โปรแกรมเชิงเสนตรง  
 จากงานวิจัยของ Irani, Mittal and Lehtihet (1989) ไดนําเสนอการใช directed graph เพื่อ
สรางความสัมพันธระหวางรอยตัดของแผนภูมิความคลาดเคล่ือนโดยใชวิธีการท่ีเรียกวา path-
tracing ในการบงช้ีความเช่ือมโยงของความคลาดเคล่ือน อยางไรก็ตาม วิธีการนี้ก็ยังเปนวิธีที่ยากตอ
การนําไปใชในทางปฏิบัติเพราะไมสามารถบงช้ีผิวหนาในการตัด (machined surface) ที่แนนอนได
และมีกฏเกณฑที่ซับซอน 
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2.4 การใชเทคนิคกราฟตนไมในการทําแผนภูมิความคลาดเคล่ือน 
Whybrew, Britton, Robinson and Sermsuti-anuwat (1990) ไดประ ยุกต ใชกราฟตนไม 

(rooted-tree graph) สําหรับชวยสรางแผนภูมิความคลาดเคล่ือน ซึ่งไดอธิบายถึงวิธีการสรางกราฟ
ตนไม (rooted-tree graph) สําหรับการลําดับขั้นตอนการตัดโลหะในแผนภูมิความคลาดเคล่ือนโดย
มีรายละเอียดดังนี้ 
 

 
 

รูปที่ 2.1 ชิ้นงานสําเร็จจากการตัดโลหะมิติตาง ๆ (Whybrew et al., 1990) 

 

 
 

รูปที่ 2.2 แผนภูมิความคลาดเคล่ือน (Whybrew et al., 1990) 



 

 

 

 

 

 

 

 

  

20 

จากรูปที่ 2.2 แสดงข้ันตอนการตัดโลหะที่เรียกวา แผนภูมิความคลาดเคล่ือนซึ่งสามารถ
สรุปขั้นตอนไดดังนี้  

ขั้นตอนท่ี 1 Operation 10 เล่ือยตัด ไดผวิ A โดยอางอิงจากผิว D 
ขั้นตอนท่ี 2 Operation 30 กลึงตัด ไดผวิ B โดยอางอิงจากผิว D 
ขั้นตอนท่ี 3 Operation 40 กลึงตัด ไดผวิ A1 โดยอางอิงจากผิว D  
ขั้นตอนท่ี 4 Operation 50 กลึงตัด ไดผวิ D1 โดยอางอิงจากผิว A1  
ขั้นตอนท่ี 5 Operation 60 เจาะรู ไดผวิ C โดยอางอิงจากผิว A1  
ขั้นตอนท่ี 6 Operation 70 กลึงตัด ไดผวิ C1 โดยอางอิงจากผิว A1 
ขั้นตอนท่ี 7 Operation 80 เจียระไน ไดผวิ A2 โดยอางอิงจากผิว D1  
ขั้นตอนท่ี 8 Operation 90 เจียระไน ไดผวิ D2 โดยอางอิงจากผิว A2 
 
จากการพิจารณาขั้นตอนทั้งหมดสามารถสรุปความสัมพันธที่ถูกตัดและผิวที่เปนจุดอางอิง

ในการวัดขนาดไดดังตารางท่ี 2.1 และสามารถแสดงเปนกราฟตนไมไดดังรูปที่ 2.3 
 

ตารางท่ี 2.1 แสดงความสัมพันธของผิวท่ีถูกตัดและผิวท่ีเปนจุดอางอิงในการวัดขนาด (Whybrew et  
 al., 1990) 

การดําเนินการ 
(Operation) 

ผิวท่ีถูกตัด 
(machined face) 

จุดอางอิงในการวัดขนาด 
(location face) 

10 
30 
40 
50 
60 
70 
80 
90 

A 
B 

A1 
D1 
C 
C1 
A2 
D2 

D 
D 
D 
A1 
A1 
A1 
D1 
A2 
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รูปที่ 2.3 กราฟตนไม (Whybrew et al., 1990) 
 

 จากกราฟตนไมในรูปท่ี 2.3 เราสามารถคํานวณความคลาดเคล่ือนของมิติที่สนใจได
เชน มิติระหวางผิว A2 กับผิว B จะมีความคลาดเคล่ือนเทากับผลรวมของความคลาดเคล่ือนของการ
ตัดท่ีอยูในเสนทางระหวางผิว A2 และผิว B นั่นคือ ผลรวมของความคลาดเคล่ือนของ B - D, D -
 A1, A1 - D1 และ D1 - A2 เทากับ ± (0.025+0.025+0.025+0.005) = ±0.080 mm เปนตน 

วิธีการของ Whybrew et al. (1990) เปนวิธีที่งายตอการทําความเขาใจและไมตองอาศัย
กฎเกณฑที่ยุงยากซับซอนและสามารถนํามาประยุกตใชในการสรางความสัมพันธของมิติไดอยาง
ดี จึงเปนจุดเริ่มตนในการนําไปสรางเปนแบบจําลองทางคณิตศาสตรของสมการเชิงเสนตรงเพื่อให
สามารถดําเนินการไดงายบนคอมพิวเตอร โดย Ngoi (1992) และ ji (1993)ไดใชเทคนิคของกราฟ
ตนไมสรางแบบจําลองทางคณิตศาสตรสําหรับการกําหนดความคลาดเคล่ือนในแผนภูมิความ
คลาดเคล่ือน โดยนําเสนอตัวอยางในการเปรียบเทียบ การแกปญหาระหวางวิธีโปรแกรมเชิง
เสนตรงกับวิธีการคํานวณแบบลองผิดลองถูกดวยมือ (Eary and Johnson, 1962) จากน้ันก็มีการนํา
แบบจําลองทางคณิตศาสตรนี้ไปพัฒนาตอเพื่อหาขนาดท่ีเกิดจากการตัดในแตละครั้ง (working 
dimensions) และแบงความคลาดเคล่ือนโดยอัตโนมัติในแผนภูมิความคลาดเคล่ือน (Ngoi and 
Ong, 1993a; 1993b) ซึ่งใชเทคนิคท่ีเรียกวา path-tracing technique และแกปญหาโดยใชระบบของ
สมการเชิงเสนตรง นอกจากน้ันยังสามารถนําไปใชอธิบายวิธีการจัดลําดับกระบวนผลิตในแผนภูมิ
ความคลาดเคล่ือนโดยอัตโนมัติ (Ngoi and Fang, 1994; Ngoi and Cheong, 1998) ซึ่งงานวิจัยท่ี
กลาวมาขางตนยังคงตองอาศัยโปรแกรม LINDO ในการหาผลลัพธที่ เหมาะสมท่ีสุดใหกับ
แบบจําลองทางคณิตศาสตรที่สรางขึ้นมา 
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นอกจากน้ีเทคนิคของกราฟตนไมยังสามารถนําไปประยุกตใชในเขียนโปรแกรม
คอมพิวเตอรชวยในการวางแผนกระบวนการผลิต (Sermsuti-anuwat, Whybrew and McCallion, 
1995) และยังนําไปใชแสดงความสัมพันธระหวางการออกแบบกับการวางแผนการผลิตในช้ินงานท่ี
มีรูปทรงสามมิติไดอีกดวย (Thimm, Britton and Fok, 2004)  
 

2.5 วิธีการสรางกราฟตนไมเแสดงความสัมพันธของความคลาดเคล่ือน 
เม่ือพิจารณาการใชเทคนิคกราฟตนไมในการบันทึกรอยตัดในแผนภูมิความคลาดเคล่ือน 

จะเห็นไดวาความสัมพันธของความคลาดเคล่ือนของรอยตัดทุกรอยตั้งแตตน จนเปนชิ้นงาน
สําเร็จรูป สามารถสรุปไดเปนกราฟชุดเดียว เพราะฉะน้ันเราอาจพิจารณาวาเม่ือมิติชุดใหมมีระนาบ
อางอิงของการบอกขนาดเปล่ียนแปลงเกิดจากมิติชุดเกาที่ถูกตัดมากอน นั้นคือ เราสามารถใช
เทคนิคกราฟตนไมแสดงความสัมพันธของความคลาดเคล่ือนระหวางมิติชุดเกาและมิติชุดใหมได 

รูปท่ี 2.4 แสดงช้ินงานกลึงเพลาเหล็กกลาซึ่งและมีการบอกขนาดความคลาดเคล่ือนของมิติ
ความยาวเปนคาเบ่ียงเบนเทา ๆ กันจากขนาดมูลฐาน (equally bilateral tolerancing) เพื่อใหเขาใจได
งายขึ้น  ในรูปนี้ได เขียนกํากับมิติ เกาทุกมิติดวยสัญลักษณของการบอกขนาดเปน  (Y1±y1) 
ถึง (Y4±y4) ซึ่งเปนมิติที่อยูดานบนท้ังหมดของรูปและกําหนดให (X1±x1) ถึง (X4±x4) เปนมิติ
ใหมเม่ือระนาบอางอิงของการบอกขนาดเปล่ียนแปลง ซึ่งอยูดานลางท้ังหมดของรูป และใช
ตัวอักษร A ถึง E แทนผิวช้ินงานที่เกี่ยวของกับมิติของขนาด 

 

 
 

รูปที่ 2.4 ชิ้นงานตัวอยางสําหรับการคํานวณมิติความยาว 4 มิติ 
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วิธีการสรางความสัมพันธของความคลาดเคล่ือนของมิติชุดเกาและมิติชุดใหมจะอาศัยการ
สรางกราฟตนไมของมิติใหมเปนหลักในการกําหนดความสัมพันธ โดยมีขั้นตอนดังนี้  

1) สเก็ตชภาพฉายต้ังฉากของช้ินงานที่แสดงมิติซึ่งเกี่ยวของกับการเปล่ียนแปลงระนาบ 
อางอิง และกําหนดชื่อเปนตัวอักษรใหกับผิวงานที่เปนขอบเขตของขนาดท้ังหมด  
(ผิว A, B, C, D, E ในวงกลมของรูปที่ 2.4) 

2) สรางกราฟสําหรับมิติใหมในรูปที่ 2.4 โดยการเขียนตัวอักษรของผิวเริ่มตนไวตอน 
บนสุด โดยเร่ิมจากผิวใดของช้ินงานก็ได ในรูปที่ 2.5 เริ่มจาก A และเรียก A วา 
โหนด (node) A  

3) พิจารณาวามีมิติใดบางที่เกี่ยวของกับโหนดเริ่มตนน้ี ใหลากลูกศรออกจากโหนดเร่ิมตน 
ชี้ไปยังอักษรที่ระบุผิวปลายของมิติเหลานั้น ผลของขั้นตอนน้ี คือเสนเชื่อมโยง (links)  
AB, AC, และ AE ของมิติ X1 และ X2 และ X3 ตามลําดับ และมีโหนดท่ีเกิดขึ้นใหม 
คือ B, C และ E 

4) พิจารณาโหนดที่เกิดขึ้นใหมคือ B, C และ E โดยลากลูกศรออกจากโหนดแลวทํา 
เชนเดียวกับขั้นตอนท่ี 3 จนครบทุกมิติ จะไดกราฟตนไมของมิติใหมที่สมบูรณ ดังรูป 
ที่ 2.5 

 

 
 

รูปที่ 2.5 กราฟตนไมสําหรับมิติใหม 
 

จากกราฟตนไมรูปที่ 2.5 เราสามารถสรุปความสัมพันธระหวางความคลาดเคล่ือนของมิติ
ชุดเกาและเสนทางของกราฟท่ีเกี่ยวของกับมิติชุดใหมไดดงัตารางที่ 2.2 
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ตารางที่ 2.2 ความสัมพันธของความคลาดเคล่ือนของมิติเกาและมิติใหม 
ความคลาดเคล่ือนของมิติเกา ผิวช้ินงานของมิติเกา ความคลาดเคล่ือนของมิติใหม 

y1 (±0.12) AB x1 
y2 (±0.08) BC x1, x2 
y3 (±0.08) CD x2, x3, x4 
y4 (±0.10) DE x4 

 
2.6 การโปรแกรมเชิงเสนตรงกับการกระจายความคลาดเคล่ือน 
 การโปรแกรมเชิงเสนตรง หมายถึง ระเบียบวิธีทางคณิตศาสตรเพื่อหาคาที่เหมาะสมท่ีสุด
ซึ่งเปนคาสูงสุด (maximize) หรือตํ่าสุด (minimize) ของเปาหมายท่ีกําหนด ภายใตเง่ือนไขบาง
ประการ โดยเปาหมายจะตองแสดงอยูในรูปสมการเสนตรง สําหรับเงื่อนไขอาจอยูในรูปสมการ
หรืออสมการเสนตรงก็ได 

2.6.1 สมการเปาหมาย (objective function)  
 สมการเปาหมายสําหรับปญหาการกระจายคาความคลาดเคล่ือน คือ การสราง

สมการเชิงเสนตรงแสดงความสัมพันธระหวางมิติเกากับมิติใหม โดยใชหลักการคือ ผลรวมของ
ความคลาดเคล่ือนสะสมของมิติใหมจะตองมีคามากที่สุดเพื่อใหสามารถผลิตไดงายและช้ินงานทํา
หนาที่ไดเสมอ โดยสามารถเขียนเปนรูปแบบของสมการเปาหมายไดดังนี้ 

 
Max Z = x1 + x2 + ... + xn  โดยที่ i =1,…,n              (2.1) 

 
 กําหนดให xi = คาความคลาดเคลื่อนที่มิติใหมใด ๆ 
  n = จํานวนของมิติทั้งหมด 

2.6.2 สมการขอจํากัด (constraints) 
 สมการขอจํากัดของปญหาปญหาการกระจายคาความคลาดเคล่ือน นั้นสามารถ

แบงออกเปน 2 เงื่อนไขดังนี้ 
 1) ผลรวมของความคลาดเคล่ือนสะสมของมิติใหมจะตองมีคานอยกวาความ
คลาดเคล่ือนของมิติเกาท่ีเก่ียวของเพื่อใหชิ้นงานสามารถใชงานไดเสมอ ซึ่งสามารถสรางอสมการ
แสดงความสัมพันธระหวางมิติชุดเกาและมิติชุดใหมได เชน มิติเกา Y3 ระหวางผิว C และ D ใน
แบบ  (รูปที่  2.4) จะเกิดจากเสนทางในกราฟ  (รูปที่  2.5)  จาก  C ถึง  D ประกอบดวยมิติ  X2 
X3 และ  X4 ซึ่งจะเขียนเปนอสมการแสดงความสัมพันธของความคลาดเคล่ือนของมิติได



 

 

 

 

 

 

 

 

  

25 

เปน x2+x3 + x4 ≤ y3 และสามารถเขียนรูปแบบของสมการขอจํากัดไดดังนี้ 
 

x1 ≤ y1   โดยที่ i =1,…,n              (2.2) 
 
       x1+ x2 ≤ y2   โดยที่ i =1,…,n              (2.3) 
 
  x2+x3+ x4 ≤ y3   โดยที่ i =1,…,n              (2.4) 
 

x4 ≤ y4   โดยที่ i =1,…,n              (2.5) 

 
 กําหนดให yi = คาความคลาดเคลื่อนที่มิติใหมใด ๆ 
  n = จํานวนของมิติทั้งหมด 
 2) ขอจํากัดท่ีเก่ียวกับกระบวนการผลิตตองมีความสามารถในการผลิตไมนอยกวา
คาเกรดความคลาดเคล่ือนสากล (International Tolerance Grade ISO 286-1) (รายละเอียดแสดงใน
ภาคผนวก ก) ซึ่งสามารถเขียนรูปแบบของสมการขอจํากัดไดดังนี้ 
 

xi ≥ เกรดความคลาดเคล่ือนสากล  โดยที่ i =1,…,n              (2.6) 

 
 จากช้ินงานตัวอยางในรูปที่ 2.4 สามารถสรุปเปนตัวแบบของปญหาโปรแกรมเชิง
เสนตรงท้ังหมดไดดังนี้ 
 สมการเปาหมาย 

 
Max Z = x1 + x2 + x3 + x4                 (2.7) 

 
 สมการขอจํากัด 

 
x1 ≤ 0.12                 (2.8) 
 

      x1 + x2 ≤ 0.08                 (2.9) 
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            x2 + x3 + x4 ≤ 0.08               (2.10) 
 

x4 ≤ 0.10               (2.11) 
 
x1 ≥ 0.042               (2.12) 
 
x2 ≥ 0.035               (2.13) 
 
x3 ≥ 0.042               (2.14) 
 
x4 ≥ 0.042               (2.15) 

 
สมการท่ี (2.12) ถึง (2.15) เปนขอจํากัดท่ีเก่ียวกับกระบวนการผลิต ในท่ีนี้กําหนดให

มีความสามารถในการผลิตไดไมนอยกวาคาเกรดความคลาดเคล่ือนสากล 10 หรือ IT 10 ทั้งหมด 
 

2.7 ขอจํากัดของโปรแกรมสําเร็จรูปทั่วไป 
โปรแกรมสําเร็จรูปสวนใหญออกแบบมาเพ่ือใชสําหรับการแกปญหาทั่วไป โดยไม

เฉพาะเจาะจงตองานใดงานหน่ึง เชน การหาผลลัพธที่เหมาะสมใหกับปญหาการแบงคาความ
คลาดเคลื่อน ดังน้ันการใชโปรแกรมสําเร็จรูปท่ัวไปจึงมีขอจํากัดคือ ผูใชตองทําการสรางสมการขึ้น
ใหมทุกครั้งท่ีมีการเปลี่ยนแปลงของคา IT No ดังตัวอยางในหัวขอ 2.6 จะพบวาในตอนเร่ิมตนได
กําหนดคา IT No ไวที่ IT 10 ทั้งหมด แตผลการคํานวณดวยโปรแกรมสําเร็จรูปทั่วไปไมสามารถ
คํานวณหาคําตอบได จึงตองมีการปรับเปล่ียนและกําหนดคา IT No เริ่มตนใหม ซึ่งอาจตองเสียเวลา
ทําการทดลองเปล่ียนคาใหมหลายครั้งกวาจะไดคําตอบท่ีดีที่สุด สงผลใหตองส้ินเปลืองเวลาในการ
ทํางานมากข้ึน ดังน้ันในงานวิจัยน้ีจึงไดพัฒนาโปรแกรมคอมพิวเตอรขึ้นใหม โดยรวบรวมขั้นตอน
การทํางานต้ังแตวิธีในการสรางกราฟตนไมไปจนถึงการคํานวณหาผลลัพธที่เหมาะสมที่สุดของ
ปญหาการแบงคาความคลาดเคล่ือนโดยใชวิธีซิมเพล็กซ  โปรแกรมสามารถปรับเปล่ียน
คา IT No ไดเองโดยอัตโนมัติและใหครอบคลุมไดมากท่ีสุด เพื่อลดขั้นตอนการทํางานท่ีไมจําเปน
และใหผูใชสามารถทํางานไดงายและมีความรวดเร็วย่ิงขึ้น 
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2.8 สรุป 
วิธีการวิเคราะหความคลาดเคล่ือนไดรับการพัฒนามาตลอด 50 ปที่ผานมา เพราะขนาดของ

ความคลาดเคล่ือนที่กําหนดใหกับมิติของชิ้นงานมีผลโดยตรงตอคาใชจายในการผลิต งานวิจัย
ทางดานวิศวกรรมความคลาดเคล่ือน (Tolerance Engineering) จึงเปนท่ีสนใจของนักวิจัยท้ังหลายท่ี
เก่ียวของกับการวางแผนกระบวนการ (process planning) การออกแบบผลิตภัณฑ (product design) 
การวัดละเอียด  (metrology) และการควบคุมคุณภาพ  (quality control) ยิ่ ง มีการประยุกตใช
คอมพิวเตอรดวยแลวจึงเปนแรงสงใหเกิดการขยายตัวของงานวิจัยทางดานการวิเคราะหความ
คลาดเคลื่อนอยางแพรหลาย กราฟตันไม (rooted-tree graph) เปนผลพวงจากวิวัฒนาการน้ันดวย ซึ่ง
เราสามารถนําเทคนิคของกราฟตนไมมาประยุกตใชกับการสรางความสัมพันธของความ
คลาดเคล่ือนจึงเปนวิธีที่สามารถทําไดงาย รวดเร็วและสามารถนําไปสรางเปนแบบจําลองทาง
คณิตศาสตร โดยใชความเชื่อมโยงของเสนทางท่ีแสดงความสัมพันธของมิติตาง ๆ เปนตัวสราง
สมการความสัมพันธของความคลาดเคล่ือน เพื่อใชในการคํานวณหาคาท่ีเหมาะสมดวยวิธีการ
โปรแกรมเชิงเสนตรง ซึ่งในงานวิจัยนี้จะไดใชเทคนิคที่กลาวมาขางตนเพื่อนําเสนอในรูปแบบของ
โปรแกรมคอมพิวเตอรสําเร็จรูป 



 

 

 

 

 

 

 

 

บทที่ 3 
โครงสรางโปรแกรม 

 

งานวิจัยนี้ไดนําเทคนิคของกราฟตนไมมาใช เปนหลักเกณฑในการสรางสมการ
ความสัมพันธของความคลาดเคล่ือนในรูปแบบของสมการเชิงเสนตรงเพ่ือคํานวณหาผลลัพธท่ี
เหมาะสมภายใตเง่ือนไขของคาความคลาดเคล่ือนมาตรฐานท่ีกําหนด มาพัฒนาเปนโปรแกรมช่ือ
วา “TOLOP” (Tolerance Optimization Program) โดยการพัฒนาโปรแกรมไดเลือกใชโปรแกรม    
ไมโครซอรฟวิชวลเบสิค 6 (Microsoft Visual Basic 6 หรือ VB 6) สําหรับเขียนคําส่ัง เน่ืองจากเปน
โปรแกรมที่สามารถสรางสวนติดตอกับผูใช (user interface) ไดอยางรวดเร็วและสามารถเรียนรู
วิธีการเขียนโปรแกรมไดดวยตนเอง  
 

3.1 องคประกอบของโปรแกรม TOLOP 
องคประกอบหลักของโปรแกรมสามารถแบงออกเปน  6 สวน  หรือ  6 โมดูล  ซ่ึงมี

ความสัมพันธเช่ือมโยงกันแสดงดังในรูปท่ี 3.1 

 

 
 

รูปท่ี 3.1 องคประกอบหลักของโปรแกรม TOLOP 
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3.1.1 โมดูลหลัก (main module) 
 โมดูลหลักมีหนา ท่ี เปนศูนยรวมสําหรับเ รียกใชงานในสวนตาง  ๆ  ของ

โปรแกรม โดยพื้นฐานแลวโมดูลหลัก จะเปนหนาจอหนาแรกท่ีปรากฏขึ้นหลังจากท่ีเขาสู
โปรแกรมคร้ังแรก (รูปท่ี 3.2) มีหนาจอที่ประกอบดวย ช่ือโปรแกรม ช่ือผูพัฒนาโปรแกรม 
นอกจากนั้นยังมีแถบเมนูและปุมคําส่ังตาง ๆ เหมือนกับหนาจอของโปรแกรมใชงานท่ัวไป มีไวให
ผูใชติดตอและส่ังงานโปรแกรม (รูปท่ี 3.3) ปุมคําส่ังเหลานี้ไดแก  
  - File สําหรับจัดการเกี่ยวกบัไฟล เชน เปดไฟล บันทึกขอมูล หรือ พิมพ 
   ขอมูล เปนตน 
  - Window สําหรับแสดงรายละเอียดหนาจอของโมดูลตาง ๆ ท่ีมีการทํางานอยู 
  ท้ังหมดไดแก หนาจอแสดงการปอนจํานวนมิติ (Input Dim) หนาจอแสดงการ 
  ปอนขอมูล (Input Data) หนาจอแสดงกราฟตนไม (Tree Graph) หนาจอแสดง 
  สมการเชิงเสน (Equation) หนาจอแสดงคําตอบท่ีเหมาะสมท้ังหมด (Feasible  
  Solution) และหนาจอแสดงคําตอบท่ีดีท่ีสุด (One Best Solution) 
 - Answer สําหรับแสดงคําตอบ สามารถแสดงไดท้ังคําตอบท่ีดีท่ีสุดซ่ึงมี 
  คา objective function มากท่ีสุด (One Best Solution) และคําตอบท่ีเหมาะสม 
  อ่ืน ๆ (Feasible Solution) ซ่ึงหมายถึงคําตอบท่ีผูใชสามารถเลือกมาใชงานได 
  ถึงแมจะไมใชคําตอบท่ีมีคาผลรวมของความคลาดเคล่ือนมากท่ีสุด แตก็เปน 
  คําตอบท่ีอยูในเง่ือนไขของเกรดความคลาดเคล่ือนมาตรฐานท่ีเรากําหนดให 
 - Run สําหรับเร่ิมตนใชงานโปรแกรมเพื่อเขาสูหนาจอสําหรับปอนจํานวนมิต ิ
 - Help เปนปุมท่ีมีไวเพื่อแนะนํารายละเอียดและวิธีการใชงานของโปรแกรม 
 สวนดานลางของหนาจอจะมีแถบสถานะ (status bar) เพื่อแสดงสถานะของไฟลท่ี
เก็บบันทึกขอมูลพรอมท้ังแสดงวันท่ีและเวลาขณะท่ีใชโปรแกรม  
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รูปท่ี 3.2 สวนประกอบของหนาจอเร่ิมตนหรือโมดูลหลัก 

 

 
 

รูปท่ี 3.3 สวนประกอบของแถบเมนู 
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หลังจากเขาสูโปรแกรมแลวการแกปญหาแตละครั้งจะเกิดข้ึนในโมดูลหลักซ่ึงครอบคลุม
การทําหนาท่ีของโมดูลอ่ืน ๆ โดยมีข้ันตอนท่ัวไปแสดงไดดังแผนภูมิรูปท่ี 3.4 เร่ิมจากการรับขอมูล
จากผูใชมาสรางกราฟตนไมเพื่อแสดงความสัมพันธระหวางมิติชุดเกาและมิติชุดใหม และสราง
ตารางคาความคลาดเคล่ือนมาตรฐาน จากนั้นนําความสัมพันธท่ีไดจากกราฟตนไมไปสรางเปน
สมการเชิงเสนตรงและดึงขอมูลคาความคลาดเคลื่อนมาตรฐานมาจากตารางขอมูล โดยหาคําตอบ
ของสมการไดจากโมดูลการคํานวณหาคาท่ีเหมาะสม (optimization module) การคํานวณในรอบ
แรกจะใชรูปแบบของเกรด IT No จํานวน 3,000 รูปแบบ เม่ือโปรแกรมทําการคํานวณครบ 3,000 
รูปแบบแลว จะทําการตรวจสอบวามีคําตอบหรือไม ถายังไมมีคําตอบจะเรียกใชโมดูลปรับปรุง
ความคลาดเคล่ือน (modification module) เพื่อปรับปรุงเง่ือนไขของคา IT No โดยอัตโนมัติ จากน้ัน
โปรแกรมจะกลับไปทําการคํานวณหาคําตอบในโมดูลการคํานวณหาคาท่ีเหมาะสมใหมจนกวาจะ
ไดคําตอบท่ีเหมาะสมตอไป 

 

 
 

รูปท่ี 3.4 ข้ันตอนการทํางานภายในโมดูลหลัก 
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3.1.2. โมดูลปอนขอมูล (Input module) 
 โมดูลปอนขอมูล มีหนาท่ีรับขอมูลตาง ๆ ท่ีผูใชปอนใหกับโปรแกรมและเก็บ

บันทึกไว ในฐานขอ มูล เพื่ อใชประมวลผล  เ ม่ือ ผู ใชกดปุม  Run จากหน าจอของโมดูล
หลัก หรือ เรียกใชคําส่ัง New ในแถบเมนู จะปรากฎหนาจอของโมดูลปอนขอมูลข้ึนมาดังรูป
ท่ี 3.5 ซ่ึงหนาจอจะประกอบดวย ชองวางหมายเลข 1 สําหรับใหผูใชปอนจํานวนมิติท่ีตองการลง
ไป หลังจากนั้นโมดูลปอนขอมูลจะสรางรูปแบบของการปอนขอมูลตามจํานวนมิติท่ีกําหนดดัง
แสดงในหมายเลข 2 สําหรับมิติจํานวน 4 มิติ ขอมูลท่ีตองทําการปอนใหกับโปรแกรม ไดแก 
ตัวอักษรท่ีใชแทนผิวช้ินงานของมิติท่ีเกิดจากการบอกขนาดในแบบและท่ีเกิดจากการกระบวนการ
ตัดโลหะ ขนาดมูลฐานของมิติเกา คาความคลาดเคล่ือนของมิติเกาและสําหรับการกําหนดคาความ
คลาดเคล่ือนมาตรฐานใหกับมิติใหมนั้นจะทําโดยการเลือกคาความคลาดเคล่ือนจากกระบวนการ 
(M/C Operation) ท่ีจะนําไปใชในการตัดมิตินั้น ๆ ของช้ินงาน เปนตน เม่ือผูใชทําการปอนขอมูล
จนครบแลวทําการบันทึกขอมูลโดยกดปุม  Save โปรแกรมจะทําการเก็บขอมูลเปนไฟล
นามสกุล .txt ในกรณีท่ีมีขอมูลเกาอยูในไฟลแลว และตองการนํามาประมวลผลก็สามารถเลือก
คําส่ังไดจากแถบเมนู File เลือกใชคําส่ัง Open จะปรากฏหนาตางดังรูปท่ี 3.6 เลือกไฟลท่ีตองการ
แลวกดปุม Open ขอมูลจะถูกนํามาใสไวท่ีหนาจอปอนขอมูล กลาวโดยสรุปการทํางานของโมดูล
ปอนขอมูลสามารถแสดงเปนข้ันตอนไดดังรูปท่ี 3.7 
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รูปท่ี 3.5 แสดงหนาจอปอนขอมูล 

 

 
 

รูปท่ี 3.6 แสดงหนาตาง Open  
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รูปท่ี 3.7 แสดงข้ันตอนการทํางานของโมดูลปอนขอมูล 
 

 3.1.3 โมดูลกราฟตนไม (tree graph module) 
 เปนสวนของการสรางกราฟตนไมของมิติชุดใหม โดยอาศัยเครื่องมือของไมโคร
ซอรฟวิชวลเบสิค 6 ท่ีเรียกวา คอนโทรลทรีวิว (control tree view) มีหนาท่ีในการแสดงผลขอมูล
ออกมาในลักษณะของโครงสรางตนไม (รูปท่ี 3.8) และใชกราฟท่ีสรางข้ึนนี้เพื่อหาเสนทางท่ีแสดง
ถึงความสัมพันธระหวางมิติชุดเกากับมิติชุดใหม จากน้ันนําเสนทางท่ีไดไปใชในการสรางสมการ
เชิงเสนตรงในโมดูลการคํานวณหาคาท่ีเหมาะสมตอไป 
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รูปท่ี 3.8 คอนโทรลทรีวิว  
 

3.1.4 โมดูลฐานขอมูลคาความคลาดเคล่ือนมาตรฐาน (International tolerance grades 
data base module) 
 โมดูลนี้แบงการทํางานเปน 2 สวนคือ สวนแรกจะเปนการสรางตารางฐานขอมูล
ของคาความคลาดเคล่ือนมาตรฐาน ISO 286-1 (IT No) โดยใชคอนโทรล MSHFlexGrid ซ่ึงเปน
เคร่ืองมือของไมโครซอรฟวิชวลเบสิค 6 มีหนาท่ีในการแสดงผลขอมูลใหอยูในรูปแบบของ
ตาราง ซ่ึงการแสดงขอมูลคาความคลาดเคล่ือนใหอยูในรูปแบบของตารางทําใหสะดวกตอการดึง
ขอมูลไปใชในการคํานวณ สําหรับสวนท่ีสองจะเปนการสรางรูปแบบของเกรด IT No 

3.1.5 โมดูลการคํานวณหาคาท่ีเหมาะสม (optimization module) 
 เปนโมดูลการประมวลผลเพ่ือหาคําตอบท่ีเหมาะสมดวยวิธีการโปรแกรมเชิง

เสนตรง มีหนาท่ีสรางสมการเชิงเสนตรงโดยอาศัยความสัมพันธจากโมดูลกราฟตนไมและดึงขอ
มูลคา IT No จากโมดูลฐานขอมูลของคาความคลาดเคล่ือนมาตรฐาน  มาสรางเปนสมการ
เร่ิมตน โดยโปรแกรมจะใชคอนโทรล MSHFlexGrid ในการดึงขอมูลตาง ๆ ใหอยูในรูปแบบของ
ตารางเพ่ือใหงายตอการคํานวณโดยใชวิธีตารางซิมเพล็กซ เม่ือทําการคํานวณในรอบแรกเสร็จ
โปรแกรมจะบันทึกผลลัพธท่ีได โดยจะบันทึกเฉพาะรอบที่สามารถหาคําตอบท่ีเหมาะสมได
เทานั้น จากน้ันทําการสับเปล่ียนรูปแบบของเกรด IT No ในรอบถัดไปจนครบ 3,000 รูปแบบ เม่ือ
โปรแกรมทําการคํานวณจนครบแลว ตรวจสอบวามีคําตอบหรือไม ถามีคําตอบใหนําคําตอบท่ีได
ท้ังหมดมาเปรียบเทียบวาคําตอบของเกรด IT No รูปแบบใดมีคาผลรวมของคาความคลาดเคล่ือนสูง
ท่ีสุดโดยจะเลือกคําตอบนั้นเปนคําตอบท่ีดีท่ีสุด ถายังไมมีคําตอบโปรแกรมจะเรียกใชโมดูล
ปรับปรุงความคลาดเคล่ือนเพื่อทําการสับเปล่ียนรูปแบบของเกรด IT No ตอไป 
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3.1.6 โมดูลปรับปรุงความคลาดเคล่ือน (modification module) 
 เปนโมดูลการปรับเปล่ียนคาความคลาดเคล่ือนแบบอัตโนมัติ โดยปรับเปลี่ยน

รูปแบบของเกรด IT No หลังจากท่ีโมดูลการคํานวณหาคาท่ีเหมาะสมทําการสับเปล่ียนรูปแบบของ
เกรด IT No มาแลว 3000 รูปแบบโดยจะทําหนาท่ีสงขอมูลรูปแบบของเกรด IT No กลับไปยัง
โมดูลการคํานวณหาคาท่ีเหมาะสมเพื่อทําการคํานวณในรอบถัดไป 
 

3.2 สรุป 
องคประกอบของโปรแกรม TOLOP มีท้ังหมด 6 สวน ในแตละสวนมีหนาท่ีและการ

ทํางานท่ีมีความเช่ือมโยงกัน โดยมีโมดูลหลัก ทําหนาท่ีเปนโปรแกรมหลักสําหรับเรียกใชงานใน
ทุกสวนของโปรแกรม โมดูลปอนขอมูล เปนสวนท่ีแสดงข้ึนมาเพื่อใหผูใชปอนขอมูลใหกับ
โปรแกรมสําหรับนําไปใชในการประมวลผลในสวนสําคัญอีก 4 สวนคือ โมดูลกราฟตนไม, โมดูล
ฐานขอมูลของคาความคลาดเคล่ือนมาตรฐาน, โมดูลการคํานวณหาคาท่ีเหมาะสม และ โมดูล
ปรับปรุงความคลาดเคลื่อน ซ่ึงจะไดอธิบายรายละเอียดเพิ่มเติมของข้ันตอนการทํางานท้ัง 4 สวนนี้
ในบทตอไป 

 



 

 

 

 

 

 

 

 

บทที่ 5 
สรุปผลการวิจัย 

 

5.1 สรุป 
งานวิจัยนี้สามารถบรรลุวัตถุประสงคท่ีตั้งไวคือ การพัฒนาโปรแกรมเพ่ือใชสําหรับแบงคา

ความคลาดเคล่ือนใหเหมาะสมกับมิติชุดใหมเม่ือระนาบอางอิงของการผลิตและการตรวจสอบ
แตกตางไปจากระนาบอางอิงของการบอกขนาดในแบบวิศวกรรม 

การใชเทคนิคกราฟตนไมทําใหงายตอการสรางความสัมพันธระหวางคาความคลาดเคล่ือน
ของมิติชุดใหมกับมิติชุดเกา โดยเทคนิคนี้ไมจําเปนตองอาศัยกฎเกณฑมากนัก เพียงแตสรางกราฟ
ของมิติชุดใหม ก็สามารถอานคามิติใชงานตาง ๆ ท่ีสัมพันธกับความตองการใชงานเดิมได
ทันที จากนั้นก็สามารถนํากราฟท่ีไดไปสรางสมการความสัมพันธสําหรับการหาคําตอบท่ีเหมาะสม
ดวยเทคนิคการโปรแกรมเชิงเสนตรง เทคนิคดังกลาวชวยทําใหเกิดความรวดเร็วในการกระจาย
ความคลาดเคลื่อน โดยเฉพาะอยางยิ่งในกรณีท่ีช้ินงานท่ีมีหลายมิติและมีกระบวนการขึ้นรูปท่ี
ซับซอน 
 โปรแกรมที่พัฒนาข้ึนไมเพียงหาผลลัพธท่ีเหมาะสมที่สุดใหกับปญหาการแบงคาความ
คลาดเคล่ือนไดเทานั้น แตยังสามารถหาผลลัพธท่ีเหมาะสมอ่ืน ๆ ท่ีมีคาความคลาดเคล่ือนอยูใน
เกณฑท่ีกําหนดไวพรอมกันดวย ซ่ึงทําใหผูใชสามารถเลือกใชไดมากกวา 1 คา โดยท่ีไมตองสราง
สมการเชิงเสนตรงดวยมือและปอนคาใหกับโปรแกรมใหมทุกคร้ังเม่ือมีการปรับเปล่ียน
คา IT No ทําใหชวยลดข้ันตอนและเวลาในการทํางานลงไดมาก ตลอดจนผูใชไมจําเปนตองมี
ความรูและความชํานาญในทางปฏิบัติมากนัก ก็สามารถกระจายความคลาดเคล่ือนใหกับมิติในการ
ผลิตหรือในการวัดขนาดใหมเพื่อคงไวซ่ึงความตองการใชงานของช้ินงานท่ีผูออกแบบกําหนดไว   

โปรแกรมนี้ยังมีสวนโตตอบกับผูใชเขาใจงาย อีกทั้งยังแสดงกราฟและขอมูลท่ีเปน
ประโยชนอยางครบถวน เหมาะสําหรับนักศึกษาหรือผูท่ีสนใจสามารถนํารหัสตนฉบับ (source 
code) ไปพัฒนาตอใหมีความยืดหยุนและครอบคลุมขอบเขตของงานใหมากข้ึนกวาเดิมได
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5.2 ขอจํากัดของโปรแกรม TOLOP 
 เนื่องจากโปรแกรมท่ีพัฒนาข้ึนนี้ใชสําหรับแบงคาความคลาดเคล่ือนใหกับมิติเชิงเสนตรง
ธรรมดาเทานั้น ซ่ึงไมสามารถนําไปใชในการวิเคราะหคาความคลาดเคล่ือนเชิงเรขาคณิต
ได นอกจากนั้นยังมีขอจํากัดอีกประการหนึ่ง คือ ขอจํากัดในเร่ืองของความเร็วในการประมวลผล
เมื่อช้ินงานรูปรางซับซอนและมีมิติจํานวนมาก   
 

5.3 ขอเสนอแนะในการพัฒนาตอไป 
 การพัฒนาโปรแกรมถือไดวาเปนไปตามวัตถุประสงค แตก็ยังมีหลายสวนท่ีสามารถนําไป
พัฒนาใหดีข้ึนได เชน ในกรณีท่ีช้ินงานมีมิติจํานวนมากโปรแกรมยังตองใชระยะเวลานานในการ
ประมวลผล ดังนั้นจึงควรปรับปรุงใหโปรแกรมมีความเร็วในการประมวลผลมากข้ึน ในสวนของ
การแสดงผลของกราฟควรปรับปรุงใหอยูในรูปแบบของกราฟฟกท่ีมีลักษณะใกลเคียงกับกราฟ
ตนไมมากข้ึน เพ่ือใหผูใชสามารถเขาใจไดงายข้ึนและการแสดงผลลัพธควรจะมีภาพกราฟฟกของ
ช้ินงานพรอมขนาดเพื่อใหเห็นรายละเอียดไดชัดเจนยิ่งข้ึน ดังนั้นโปรแกรมท่ีพัฒนาข้ึนนี้จึงเหมาะท่ี
จะเปนตนแบบเพื่อใหสามารถพัฒนาไปสูการนําไปใชในอุตสาหกรรมจริงตอไป 
 



 

 

 

 

 

 

 

 

รายการอางอิง 
 

Ahaluwalia, R. S. and Karolin, A. V. (1984). CATC A computer-aided tolerance control 
system. Journal of Manufacturing Systems. 3 (2) : 153-160. 

Drake, P. Jr., (1999). Dimensioning and tolerancing handbook. McGraw-Hill. 
Fainguelernt, D., Wiell, R., and Bourdet, P. (1986). Computer aided tolerancing and  

dimensioning in Process Planning, Annals of the CIRP. 35 (1): 381-386 
Farmer, L. E. and Harris, A. G. (1984). Change of datum of the dimensions on engineering 

Design drawings. International Journal of Machine Tool Design and Research. 
24 (4): 267-275. 

Gladman, C A. (1966). Manual for geometric analysis of engineering design. Australian Trade  
Publications. Sydney. 

Irani, S. A., Mittal, R. O., and Lehtihet, E. A. (1989) Tolerance chart optimization. International  
Journal of Production Research. 27 (9) : 1531-1552. 

Ji, P., (1993). A tree approach for Tolerance charting International Journal of Production 
Research. 31 (5) : 1023-1033. 

Liggett, J. V., (1993). Dimensional variations management handbook: A guide for  
quality design and manufacturing engineers. Prentice-Hall. 

Ngoi, B. K. A. (1992) Applying linear programming to tolerance chart balancing. International  
Journal of Advanced Manufacturing Technology. 7: 187-192. 

Ngoi, B. K. A., and Cheong, K. C. (1998). The apparent path tracing approach to tolerance  
charting. International Journal of Advanced Manufacturing Technology. 14:580-587 

Sermsuti-anuwat, Y., Whybrew, K., McCallion, H. (1995). CAPPFD – A tolerance-based  
feature sequencing CAPP system. Journal of Systems Engineering. 5 (1): 2-15. 

Sermsuti-anuwat, Y. (2009). Milling fixture design: a tolerance analysis approach.  
International Journal of Mechanical Engineering Education. 37 (2): 111-117.  

 
 
 
 



 

 

 

 

 

 

 

 

  

57 

Thimm, G., Britton, G. A., and Fok, S. C. (2004). A graph theoretic approach linking  
Design dimensioning and process planning. International Journal of Advanced  
Manufacturing Technology. 24: 261-271. 

Whybrew, K., Britton, G. A., Robinson, D. F., and Sermsuti-anuwat, Y. (1990). A graph- 
theoretic approach to tolerance charting. International Journal of Advanced  
Manufacturing Technology. 5: 175-183. 

Oyvind, Bjorke. (1978) Computer-aided tolerancing. Tapir Publishers. 



 

 

 

 

 

 

 

 

  

58 

 



 

 

 

 

 

 

 

 

 

ภาคผนวก ก 
 

ตารางเกณฑความคลาดเคลื่อนมาตรฐาน (ISO 286-2) 
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คูมือการใชงานโปรแกรม TOLOP 
 
 
 
 
 
 
 
 
 
  

 



 

 

 

 

 

 

 

 

  

คูมือการใชงานโปรแกรม 
TOLOP V.1 
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คํานํา 
 

คูมือการใชงานโปรแกรมเลมน้ีจัดทําเพื่อเปนคูมือสําหรับชวยผูใชโปรแกรมในการเร่ิมตน
ใชงานโปรแกรม TOLOP ประกอบดวย 5 บท ไดแก บทที่ 1 แนะนําโปรแกรม บทท่ี2 การเร่ิมตน
ใชงานโปรแกรม บทท่ี3 วิธีการวิเคราะหความคลาดเคล่ือนดวยโปรแกรม TOLOP ซึ่งไดแสดง
ตัวอยางการวิเคราะหและออกแบบทีละขั้นตอนอยางละเอียด 

โปรแกรม TOLOP ขณะน้ี คือ รุนท่ี 1 ผูเขียนหวังวาคูมือการใชงานโปรแกรมฉบับน้ีจะ
ชวยใหผูอานสามารถใชงานโปรแกรม TOLOP ไดอยางเต็มประสิทธิภาพ หากมีขอเสนอแนะติชม
เพื่อการพัฒนาโปรแกรมตอไปสามารถติดตอผูเขียนไดโดยตรงตามท่ีแสดงไวในคูมือฉบับนี้ 

 
 

อรวรรณ  นงนุช 



 

 

 

 

 

 

 

 

  

บทที่1  
แนะนําโปรแกรม  

 

1.1 ระบบปฏิบัติการที่ตองการ 
1) ระบบปฏิบัติการ Windows 98 ขึ้นไป (แนะนํา Windows XP) 
2) เครื่องคอมพิวเตอรที่มี CPU ที่เปน Pentium 100 MHz ขึ้นไป 
3) หนวยความจํา 32 MB ขึ้นไป 
4) ไดรฟซีดีรอม (CD-ROM) สําหรับติดต้ังโปรแกรม 
5) การดแสดงผลที่สามารถแสดงผลที่ความละเอียดต้ังแต 800x600 ขึ้นไป (แนะนํา  

1024x768) 
6) เมาสและคียบอรดท่ีสนับสนุนการทํางานของวินโดวส 

 

1.2 ขั้นตอนการติดต้ังโปรแกรม 
1) เปดหนาตาง My Computer และเลือกไปยังโฟลเดอรที่เก็บไฟลไวและดับเบิลคลิกที่ไฟล  

Setup จะแสดงหนาตางดังรูปที่ M1.1 
2) ทําตามข้ันตอนท่ีแสดงในตัวติดต้ังโปรแกรมทีละขั้นตามลําดับ 

 

 
 

รูปที่ M1.1 หนาตางการติดต้ังโปรแกรม 
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1.3 การเขาสูโปรแกรม 
การเขาสูโปรแกรม TOLOP สามารถทําไดโดยไปที่ Window Start menu > Program > 

TOLOP ดังรูปที่ M1.2  

 

 
 

รูปที่ M1.2 



 

 

 

 

 

 

 

 

  

บทที่2  
การเริ่มตนใชงานโปรแกรม 

 

2.1 การเริ่มตนใชงานโปรแกรม TOLOP 
หลังจากเขาสูโปรแกรม TOLOP ตามขั้นตอนในหัวขอ 1.3 แลว โปรแกรมจะแสดงหนาจอ

เริ่มตนดังรูปท่ี M2.1 เชนเดียวกับโปรแกรมสวนใหญที่ทํางานภายใตระบบปฏิบัติการวินโดวส โดย
มีสวนประกอบของหนาจอดังตอไปน้ี 

1) แถบเมนู (Menu bar) มีไวใหผูใชติดตอและส่ังงานโปรแกรม  
2) ชื่อโปรแกรมและช่ือผูพัฒนาโปรแกรม 
3) แถบสถานะ (Status bar) สําหรับแสดงสถานะของไฟลที่เก็บบันทึกขอมูลพรอมท้ัง 

แสดงวันท่ีและเวลาขณะที่ใชโปรแกรม 

 

 
 

รูปที่ M2.1 สวนประกอบของหนาจอเร่ิมตน 
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2.2 แถบเมนู (Menu bar ) 
แถบเมนูที่แสดงอยูดานบนของหนาจอเปนคํา ส่ังท่ีมีไวใหผู ใชงานติดตอส่ังงาน

โปรแกรม ซึ่งมีสวนประกอบดังรูปที่ M2.2 

 

 
รูปที่ M2.2 สวนประกอบของแถบเมนู 

 

คําอธิบายเพิ่มเติมสําหรับแถบเมนู 
File>New    สรางงานใหม 
File>Open    เปดงานเกา 
File>Save As    บันทึกงานในช่ือใหม 
File>Print    พิมพรายงาน 
File>Exit    ออกจากโปรแกรม 
 
Window>Input Dim   หนาตางแสดงหนาตางปอนขอมูลจํานวนมิติ 
Window>Input Data   หนาตางแสดงหนาตางปอนขอมูล 
Window>Tree Graph Expand  หนาตางสําหรับแสดงการขยายขนาดของกราฟตนไม 
Window>Equation   หนาตางแสดงสมการเร่ิมตน 
Window> Feasible Solution  หนาตางแสดงคําตอบที่เหมาะสม 
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Answer>One Best Solution  แสดงคําตอบที่ดีทีสุ่ด 
Answer>Feasible Solution  แสดงคําตอบที่เหมาะสม 
 
Run     เริ่มตนการทํางานของโปรแกรม 
Help>How To Use   วิธีใชงานโปรแกรม 
 

2.3 การปอนขอมูล (Input Data) 
เม่ือผูใชกดท่ีแถบเมนู Run (รูปที่ M2.3) โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูล (รูป

ที่ M2.4) ในชองหมายเลข 1 ใหปอนจํานวนมิติที่ตองการ โดยจํานวนมิติที่ปอนจะตองมีจํานวน
ตั้งแต  3 มิ ติขึ้นไป  เ ม่ือปอนตัวเลขจํานวนมิติแลวใหกดท่ีปุม  OK หรือ  กดท่ีปุม  Enter บน
คียบอรด จากน้ันโปรแกรมจะแสดงหนาจอสําหรับปอนรายละเอียดของขอมูลในกรอบหมายเลข 2   

 

 
 

รูปที่ M2.4 หนาตางสําหรับปอนขอมูล 
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รูปที่ M2.4 หนาตางสําหรับปอนขอมูล 
 

การปอนขอมูลผูใชจะตองปอนขอมูลใหครบทุกชอง โดยรายละอียดของขอมูลท่ีตองปอน
ใหกับโปรแกรมมีดังนี้ (รูปที่ M2.5) 

1) ปอนตัวอักษรที่ระบุผิวเริ่มตนของมิติเกาในชองขอความ From  
2) ปอนตัวอักษรที่ระบุผิวปลายของมิติเกาในชองขอความ To 
3) ปอนขนาดมูลฐานของมิติเกาในชองขอความ Basic Dim 
4) ปอนคาความคลาดเคล่ือนของมิติเกาลงในชองขอความ (+/-)1/2 Tol 
5) ปอนตัวอักษรที่ระบุผิวเริ่มตนของมิติใหมในชองขอความ From  
6) ปอนตัวอักษรที่ระบุผิวปลายของมิติใหมในชองขอความ To 
7) ปอนขอมูลกระบวนการผลิตโดยคลิกเลือกที่ลูกศรในชองขอความ M/C Operation 
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รูปที่ M2.5 การปอนขอมูลใหกับโปรแกรม 

 
การปอนขอมูลใหกับโปรแกรมจะตองปอนเฉพาะขอมูลที่ เปนตัวอักษรใหกับชอง

หมายเลข 1, 2, 5 และ 6 เทานั้น ถาผูใชปอนขอมูลที่เปนตัวเลข เคร่ืองหมาย หรือ สัญลักษณอื่นใด
โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (a) การปอนขอมูลใหกับชองหมายเลข 3 จะตอง
ปอนเฉพาะขอมูลท่ีเปนตัวเลขเทาน้ัน ถาผูใชปอนขอมูลท่ีเปนตัวอักษร เครื่องหมาย หรือ 
สัญลักษณอื่นใด โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (b) และการปอนขอมูลใหกับชอง
หมายเลข 4 จะตองปอนเฉพาะขอมูลท่ีเปนตัวเลขเทาน้ัน ถาผูใชปอนขอมูลที่ เปนตัวอักษร 
เครื่องหมาย หรือ สัญลักษณอื่นใด โปรแกรมจะแสดงกลองขอความดังรูปที่ M2.6 (c) 

 

 
 

รูปที่ M2.6  



 

 

 

 

 

 

 

 

 
 

 

 
70 

2.4 การบันทึกขอมูล (Save Data) 
หลังจากท่ีผูใชปอนขอมูลเสร็จเรียบรอยแลว ผูใชสามารถทําการการบันทึกขอมูลไวใน

หนวยความจําไดโดยมีขั้นตอนการบันทึกดังนี้ 
1) คลิกที่คําส่ัง File > SaveAs บนแถบเมนู หรือคลิกที่ปุม SAVE จะมีหนาตาง Save As  

แสดงข้ึนมาดังรูปที่ M2.7 
2) เลือกโฟลเดอรที่ตองการบันทึกขอมูล 
3) ปอนชื่อไฟลที่ตองการบันทึกขอมูลลงในชอง File name 
4) คลิกที่ปุม Save ขอมูลจะถูกบันทึกเปนไฟลนามสกุล .txt เชน 4 dimension.txt  

 

 
รูปที่ M2.7 หนาตางบันทึกขอมูล 
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2.5 การเริ่มงานใหม (New) 
เม่ือตองการเร่ิมแผนงานใหมใหไปที่คําส่ังบนแถบเมนู คลิกที่ File > New รูปที่ M2.8

จากน้ันโปรแกรมจะแสดงหนาจอใหใสจํานวนมิติใหม ดังรูปที่ M2.9 

 

 
 

รูปที่ M2.8 

 

 
 

รูปที่ M2.9 



 

 

 

 

 

 

 

 

 
 

 

 
72 

2.6 การเปดขอมูล (Open data) 
การเปดขอมูล คือ การนําขอมูลที่บันทึกไวในหนวยความจํามาใสลงในชองวางของหนาจอ

ปอนขอมูลโดยมีขั้นตอนดังนี้ 
1) คลิกที่ File > Open บนแถบเมนูจะมีหนาตาง Open แสดงข้ึนมาดังรูปที่ M2.10 
2) ไปยังโฟลเดอรที่เก็บไฟลขอมูลไว 
3) เลือกไฟลขอมูลที่ตองการ 
4) คลิกที่ปุม Open ขอมูลจะถูกปอนลงในชองวาง (ขอมูลที่สามารถเปดไดตองมีนามสกุล 

เปน .txt) จากน้ันขอมูลก็จะถูกนําไปใสไวในชองวางของหนาจอปอนขอมูล ดังรูป 
ที่ M2.11 

 

 
 

รูปที่ M2.10 หนาตางคําส่ังเปดไฟลขอมูล 

 

 
 

รูปที่ M2.11 
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2.7 การหาผลลัพธ 
 เม่ือใสขอมูลและบันทึกขอมูลเรียบรอยแลวข้ันตอไปจะเปนการหาผลลัพธ โดยกดที่ปุม 
SOLVE โปรแกรมจะแสดงกลองขอความถามวาตองการ RUN เกรด IT No จากนอยไปมาก
หรือไม” ดังรูปท่ี  M2.12 ถาตองการใหโปรแกรมรันคา  IT No จากคานอยไปคามากใหกด
ปุม Yes โปรแกรมจะทําการประมวลผลโดยเริ่มคํานวณจากคา IT No นอยที่สุดกอน แตถาตองการ
ใหโปรแกรมประมวลผลจาก IT No มากไปนอย ใหกดปุม No โปรแกรมก็จะทําการคํานวณจาก
คา IT No มากท่ีสุดกอน  

 

 
 

รูปที่ M2.12 
 

ในกรณีที่จํานวนรูปแบบของ IT No ไมถึง 3000 รูปแบบ โปรแกรมจะทําการประมวลผล
โดยสามารถหาคําตอบไดในคราวเดียว ถาพบคําตอบโปรแกรมจะแสดงกลองขอความดังรูป
ที่ M 2.13 (a) แตถาไมมีคําตอบโปรแกรมจะแสดงกลองขอความดังรูปที่ 2.13 (b) 

 

 
 

รูปที่ M2.13 
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สําหรับกรณีที่มีจํานวนรูปแบบมากกวา 3000 รูปแบบ โปรแกรมจะทําการประมวลผลใน
รอบแรกโดยใช IT No จํานวน 3000 รูปแบบกอน เม่ือทําการประมวลผลครบ 3000 รูปแบบแลว ถา
พบคําตอบโปรแกรมจะแสดงกลองขอความ  ดังรูป ท่ี  M2.14 (a) แตถ าประมวลผลครบ 
3000 รูปแบบแลวยังไมพบคําตอบ โปรแกรมจะแสดงกลองขอความ ดังรูปที่ M2.14 (b) 

 

 
 

รูปที่ M2.14 
 

2.7.1 หนาจอแสดงผลลพัธ 
 หนาจอแสดงผลลัพธสามารถเลือกใหแสดงผลได 2 หนาจอ ดังนี้ 
 1) หนาจอแสดงคําตอบที่ดีที่สุด ซึ่งเปนคําตอบที่มีผลรวมของคาความ 

คลาดเคลื่อนมากที่สุดแสดงดังรูปที่ M2.15 สามารถบันทึกคําตอบโดยกด 
ปุม Save และพิมพคําตอบโดยกดปุม Print 

 

 
 

รูปที่ M2.15 หนาจอแสดงคาํตอบที่ดีทีสุ่ด 
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 2) หนาจอแสดงคําตอบที่เหมาะสม ซึ่งเปนคําตอบที่สามารถนําไปเลือกใชไดแต 
ไมใชคําตอบที่มีผลรวมของคาความคลาดเคล่ือนมากที่สุด แสดงดังรูป 
ที่ M2.16 สามารถบันทึกคําตอบโดยกดปุม Save และพิมพคําตอบโดยกด 
ปุม Print 

 

 
 

รูปที่ M2.16 หนาจอแสดงคาํตอบที่เหมาะสม 
 

2.7.2 หนาจอแสดงกราฟตนไม  
 หนาจอนี้จะแสดงกราฟตนไมที่สรางขึ้นจากความสัมพันธของมิติใหมโดยมี
ลักษณะดังรูปที่ M2.17 

 

 
 

รูปที่ M2.17 หนาจอแสดงกราฟตนไม 
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2.8 การพิมพรายงาน (Print) 
การส่ังพิมพขอมูลจะตองทําการบันทึกขอมูลลงไฟลกอนทุกครั้ง ไมเชนน้ันโปรแกรมจะ

ไมสามารถส่ังพิมพขอมูลได เม่ือเลือกคําส่ัง Print แลว โปรแกรมจะแสดงหนาตาง Print ดังรูปที่ 
M2.17 ซึ่งการส่ังพิมพขอมูลสามารถส่ังพิมพไดจากคําส่ังที่อยูในแถบเมนู ตาง ๆ ดังนี้  

1) คลิกที่คําส่ัง File > Print > Form main เพื่อพิมพขอมูลของหนาตางหลัก 
2) คลิกที่คําส่ัง File > Print > Equation เพื่อพิมพสมการ 
3) คลิกที่คําส่ัง File > Print > One Best Solution เพื่อพิมพคําตอบที่ดีที่สุด 
4) คลิกที่คําส่ัง File > Print > Feasible Solution เพื่อพิมพคําตอบที่เหมาะสมทั้งหมดที่ 

สามารถนํามาเลือกใชได 

 

 
 

รูปที่ M2.17 หนาตางคําส่ังพิมพ 
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2.9 การออกจากโปรแกรม (Exit program) 
เม่ือตองการออกจากโปรแกรมใหคลิกที่ Files > Exit หรือคลิกที่เคร่ืองหมาย × ที่ดานขวา

บนสุดของหนาตางหลัก ดังรูปที่ M2.18 

 

 
 

รูปที่ M2.18 



 

 

 

 

 

 

 

 

  

บทที่ 3 
วิธีการวิเคราะหความคลาดเคลื่อนดวยโปรแกรม TOLOP 

 
เนื้อหาในบทน้ีจะเปนการนําตัวอยางโจทยมาสาธิตการใชงานโปรแกรม TOLOP แบบเปน

ขั้นตอนเพ่ือใหเขาใจวิธีการใชงานของโปรแกรม TOLOP ยิ่งขึ้น 
 

ตัวอยางท่ี 1  
โจทยตัวอยางน้ีมีมิติของช้ินงานจํานวน 4 มิติ (รูปท่ี M3.1) ซึ่งระบุขนาดความคลาดเคล่ือน

ของมิติความยาวเปนคาเบี่ยงเบนเทา ๆ กัน โดยกําหนดให (Y1 ± y1) ถึง (Y4 ± y4) เปนมิติชุดเกา 
และ (X1 ± x1) ถึง (X4 ± x4) เปนมิติชุดใหมที่ตองการทราบคา การใชโปรแกรมเพื่อหาคาความ
คลาดเคลื่อนชุดใหม มีขั้นตอนดังนี้  

 

 
  

รูปที่ M3.1 ตัวอยางชิ้นงาน 4 มิติ 
 

1) ปอนจํานวนมิติเทากับ 4 ลงในชอง Input Number of dimensions ดังรูปที่ M3.2 จากน้ัน 
กดปุม OK หรือกดปุม Enter ที่คียบอรด  

2) โปรแกรมจะแสดงหนาจอสําหรับปอนขอมูลจํานวน 4 แถว จากน้ันใหปอนขอมูลลงใน 
ชองวางใหครบทุกชอง ดังรูปที่ M3.3 
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3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) กดปุม SOLVE เพื่อหาผลลัพธ 
5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธ ดังรูปที่ M3.4  

 

 
 

รูปที่ M3.2 

 

 

 
 

รูปที่ M3.3 
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รูปที่ M3.4 

 
คําตอบท่ีดีที่สุดของโจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมาก

ที่สุด เทากับ 0.1465 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.0665 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0135 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0245 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.0420 เลือกใชเกรดความคลาดเคล่ือน IT 10 
นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 

Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปท่ี M3.5) และหนาจอแสดงสมการเร่ิมตน (รูป
ที่ M3.6) 
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รูปที่ M3.5 

 

 
 

รูปที่ M3.6 
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ตัวอยางท่ี 2  
โจทยตัวอยางน้ีมีมิติของช้ินงานจํานวน 6 มิติ (รูปท่ี M3.7) ซึ่งระบุขนาดความคลาดเคล่ือน

ของมิติความยาวเปนคาเบี่ยงเบนเทา ๆ กัน โดยกําหนดให (Y1 ± y1) ถึง (Y6 ± y6) เปนมิติชุดเกา 
และ (X1 ± x1) ถึง (X6 ± x6) เปนมิติชุดใหมที่ตองการทราบคา การใชโปรแกรมเพื่อหาคาความ
คลาดเคลื่อนชุดใหม มีขั้นตอนดังนี้ 

1) ปอนจํานวนมิติเทากับ 6 ลงในชอง Input Number of dimensions แลวกดปุม OK หรือ 
กดปุม Enter ที่คียบอรด  

2) โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูลจํานวน 6 แถว จากน้ันทําการปอนขอมูล 
ลงในชองวางใหครบทุกชอง ดังรูปที่ M3.9 

3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) กดปุม SOLVE เพื่อหาผลลัพธ 
5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธดังรูปที่ M3.10 

 

 
 

รูปที่ M3.7 ตัวอยางชิ้นงาน 6 มิติ 
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รูปที่ M3.8 

  

 
 

รูปที่ M3.9 
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รูปที่ M3.10 

 
คําตอบท่ีดีที่สุดของโจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมาก

ที่สุด เทากับ 0.4335 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.1165 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0335 เลือกใชเกรดความคลาดเคล่ือน IT 9 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0165 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.1670 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x5 = ±0.0500 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x6 = ±0.0500 เลือกใชเกรดความคลาดเคล่ือน IT 10 
นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 

Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปที่ M3.11) และหนาจอแสดงสมการเริ่มตน (รูป
ที่ M3.12) 
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รูปที่ M3.11 

 

 
 

รูปที่ M3.12 
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ตัวอยางท่ี 3 
โจทยตัวอย าง น้ีมีมิ ติของชิ้นงานจํานวน  8 มิ ติ  (รูปที่  M3.13) ซึ่ งระบุขนาดความ

คลาดเค ล่ือนของมิ ติความยาว เปนค า เบี่ ยง เบนเท า  ๆ  กัน  โดยกํ าหนดให  (Y1 ± y1) ถึ ง 
(Y8 ± y8) เปนมิติชุดเกา และ (X1 ± x1) ถึง (X8 ± x8) เปนมิติชุดใหมที่ตองการทราบคา ขั้นตอน
การใชโปรแกรมเพื่อหาคาความคลาดเคล่ือนชุดใหม มีขั้นตอนดังนี้  

1) ปอนจํานวนมิติเทากับ 8 ลงในชอง Input Number of dimensions จากน้ันกด 
ปุม OK หรือกดปุม Enter ที่คียบอรด โปรแกรมจะแสดงหนาตางสําหรับปอนขอมูล 
จํานวน 8 แถว เชนเดียวกับทั้งสองตัวอยางที่กลาวมาขางตน จากน้ันปอนขอมูลลงใน 
ชองวางใหครบทุกชอง ดังรูปที่ M3.14 

 

 
 

รูปที่ M3.13 ตัวอยางชิ้นงาน 8 มิติ (Farmer and Harris, 1984) 
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รูปที่ M3.14 
 
3) กดปุม SAVE เพื่อทําการบันทึกขอมูล 
4) เม่ือกดปุม SOLVE เพื่อหาผลลัพธ การประมวลผลของโปรแกรมในตัวอยางนี้จะมีความ 

แตกตางจากตัวอยางทั้ง 2 ตัวอยางขางตน เนื่องจากรูปแบบของเกรด IT No ของตัวอยาง 
นี้มีมากกวา 3,000 รูปแบบ โดยจะมีจํานวนรูปแบบอยูทั้งหมด 6,561 รูปแบบ ซึ่งมา 
จาก เกรด IT No ที่ใชในแตละมิติ คือ 3 เกรด ซึ่งมีมิติทั้งหมด 8 มิติ ดังนั้นจึงมีรูปแบบ 
ของเกรด IT No ทั้งหมดที่ตองใชในการคํานวณ คือ 3^8 นั่นเอง เม่ือโปรแกรมทําการ 
ประมวลผลโดยใชรูปแบบของเกรด IT No ครบ 3,000 รูปแบบแลวจะแสดงหนาจอดัง 
รูปที่ M3.15 ซึ่งในตัวอยางนี้สามารถหาผลลัพธไดแลว แตอาจจะยังไมใชคําตอบที่ดีที 
สุด ถาตองการท่ีจะใหโปรแกรมทําการประมวลผลตอใหกดปุม Yes โปรแกรมจะแสดง 
กลองขอความใหใสจํานวนรูปแบบที่ตองการใหทําตอ ในตัวอยางนี้เราจะใหโปรแกรม 
ทําตอไปอีก 3,561 รูปแบบ ดังรูปที่ M3.16 

5) เม่ือโปรแกรมประมวลผลเสร็จแลวจะแสดงผลลัพธ ดังรูปที่ M3.17 คําตอบที่ดทีี่สุดของ 
โจทยตัวอยางนี้ คือ คําตอบที่มีคาผลรวมของคาความคลาดเคล่ือนมากท่ีสุด เทากับ  
0.3835 ซึ่งอยูในขอบเขตของความคลาดเคล่ือนมาตรฐานท่ีมากท่ีสุด โดยมีคา 
ความคลาดเคล่ือนที่ไดดังนี้ 

คาความคลาดเคลื่อนของมิติ ±x1 = ±0.1000 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x2 = ±0.0485 เลือกใชเกรดความคลาดเคล่ือน IT 9 
คาความคลาดเคลื่อนของมิติ ±x3 = ±0.0300 เลือกใชเกรดความคลาดเคล่ือน IT 8 
คาความคลาดเคลื่อนของมิติ ±x4 = ±0.0350 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x5 = ±0.0780 เลือกใชเกรดความคลาดเคล่ือน IT 10 
คาความคลาดเคลื่อนของมิติ ±x6 = ± 0.0420 เลือกใชเกรดความคลาดเคล่ือน IT 10 
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คาความคลาดเคลื่อนของมิติ ±x7 = ± 0.0335 เลือกใชความคลาดเคล่ือนมาตรฐาน IT 10 
คาความคลาดเคลื่อนของมิติ ±x8 = ± 0.0165 เลือกใชความคลาดเคล่ือนมาตรฐาน IT 8 

 

 
 

รูปที่ M3.15 

 

 
 

รูปที่ M3.16 
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รูปที่ M3.17 
 

นอกจากคําตอบท่ีดีที่สุดแลวยังสามารถเลือกใชคําตอบอ่ืน ๆ ในหนาจอของ Feasible 
Solution ได อี กด วย  และยั งสามารถ เ ลือกดู ข อ มูล อ่ืน  ๆ  ที่ ได จ ากการประมวลผลของ
โปรแกรม เชน หนาจอแสดงกราฟตนไม (รูปที่ M3.18) และหนาจอแสดงสมการเริ่มตน (รูป
ที่ M3.19) 

 

 
 

รูปที่ M3.18 
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รูปที่ M3.19 
 



 

 

 

 

 

 

 

 

 

ภาคผนวก ค 
 

รายการโปรแกรม (Program Listings) 
 
 
 
 
 
 
 
 
 

 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

ภาคผนวก ง 
 

บทความวิชาการที่ไดรับการตีพิมพเผยแพร 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

 

 

บทความวิชาการที่ไดรับการตีพิมพเผยแพร 
 

อรวรรณ  นงนุช และ ยงยุทธ  เสริมสุธีอนุวัฒน (2552). เทคนิคการกระจายคาความคลาด
เคลื่อนท่ีเหมาะสมเมื่อเดตัมของการบอกขนาดเปลี่ยนแปลง. การประชุมวิชาการขายงานวิศวกรรม
อุตสาหการ, 21 – 22 ตุลาคม 2552, มหาวิทยาลัยขอนแกน, ประเทศไทย. 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 
 
 
 



 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

ประวัติผูเขียน 
 
 นางสาวอรวรรณ  นงนุช เกิดเม่ือวันที่ 5 ตุลาคม พ.ศ. 2526 ภูมิลําเนาอยูที่บานเลขท่ี 
35/388 หมู 6 ตําบลเขาสามยอด อําเภอเมืองลพบุรี จังหวัดลพบุรี เร่ิมเขาศึกษาระดับประถมศึกษาท่ี
โรงเรียนวรพิทยา ระดับมัธยมตนที่โรงเรียนวินิตศึกษาในพระราชูปถัมภฯ ระดับมัธยมปลายท่ี
โรงเรียนพระนารายณ และเร่ิมเขาศึกษาระดับปริญญาตรีที่ สาขาวิชาวิศวกรรมโลหการ สํานักวิชา
วิศวกรรมศาสตร มหาวิทยาลัยเทคโนโลยีสุรนารี จังหวัดนครราชสีมา เม่ือป พ.ศ. 2545 และสําเร็จ
การศึกษาเม่ือป พ.ศ. 2548 หลังจากสําเร็จการศึกษาไดเขาทํางานกับ บริษัท สหวิริยาเพลทมิล
จํากัด จังหวัดชลบุรี เปนเวลา 1 ป  
 จากนั้นไดเขาศึกษาตอในสาขาวิชาวิศวกรรมอุตสาหการ สํานักวิชาวิศวกรรมศาสตร 
มหาวิทยาลัยเทคโนโลยีสุรนารี ในป พ.ศ. 2550 ในขณะที่ศึกษาตอในระดับปริญญาโท ไดเปน
ผูชวยสอนรายวิชาปฏิบัติการกรรมวิธีการผลิต ของสาขาวิชาวิศวกรรมอุตสาหการ 
 ผลงานวิจัย : ไดเสนอบทความเขารวมในการประชุมวิชาการขายวิศวกรรมอุตสาหการ 
ประจําป 2552 เรื่องเทคนิคการกระจายคาความคลาดเคล่ือนที่เหมาะสมเม่ือเดตัมของการบอกขนาด
เปล่ียนแปลง 
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